ECT IS AS BIG AS TEXAS THE STORIES AND TIPS OF ENVIRONMENTAL COMMUNICATION TEACHING

WEAVING THE THREADS OF COMMUNICATION

THE INTEL READER AND JENNY SMITH

ME MOVES: A GAME CHANGER IN THE CLASSROOM AND AT HOME

(IN)ACCESSIBLE DIGITAL TEXTBOOKS

CREATING WORKSHEET FOR INDIVIDUAL LEARNING NEEDS

USING MICROSOFT WORD WITH STUDENTS WITH DYSLEXIA
Teaching Independent Living Skills Using the Functional Skills System and the iPod touch

Close the Gap with 42 NEW Applications for the iPod touch.

4 FREE Sampler Apps!

www.conovercompany.com/ipod/apps

Thursday, October 21, 2010 • 9:30 am • Atrium 7 Room

The Conover Company • 800-933-1933 • www.conovercompany.com • sales@conovercompany.com
The Intel® Reader is changing the lives of people with reading challenges, such as dyslexia and low vision. This extraordinary mobile device takes a picture of printed text and converts it to the spoken word. It combines a high-resolution camera with the power of an Intel® Atom™ processor. Based on extensive assistive technology research, the Intel Reader is bringing the printed word to children and adults faster, so they can participate fully and excel.

Try the Intel® Reader For Yourself
Attend our hands-on workshop at the 28th Annual Closing the Gap Conference.

**Where:** Bloomington Room, Sheraton Hotel

**When:** Thursday, October 21, 2010, 11 a.m.–12 p.m.

Or visit the Don Johnston and HumanWare booths for a hands-on demo.

Learn more at [reader.intel.com](http://reader.intel.com).

Join the community on [www.experiencereader.com](http://www.experiencereader.com), [Facebook.com/intelreader](http://Facebook.com/intelreader), and [Twitter.com/intelreader](http://Twitter.com/intelreader).

Do not use the Intel® Reader as a sole means of reading safety or hazard warnings, medication labels or instructions, or financial or legal documents when a reading inconsistency or misreading of written text might put you at risk of personal injury or economic harm. For such critical reading, always use a backup means to confirm that you understand the writing, such as alternative accessible format or another person.

© 2010, Intel Corporation. All rights reserved. Intel, the Intel logo, and Intel Atom are trademarks of Intel Corporation in the U.S. and other countries. *Other names and brands may be claimed as the property of others.
6 ECT is as Big as Texas
The stories and tips of Environmental Communication Teaching
By Kelly Fonner, Andrina Hamil, Kenja James Johnson, Debra Stanley, Marguerite Horney, Ruth Solis and Beth Coletta

9 Weaving the Threads of Communication
By Marsye Kaplan and Deborah Gerson

12 The Intel Reader and Jenny Smith
The Unypical Typical Teenager

14 Me Moves: A Game Changer in the Classroom and at Home
By Roberta Scherf

17 (In)accessible Digital Textbooks
By Jaroslaw Wiazowski

23 Creating Worksheet for Individual Learning Needs
By Lee Lay Wah

26 Using Microsoft Word with Students with Dyslexia
By John Phayer

32 New AT Products and Announcements
- Texthelp Systems Announces Read&Write 4 GOLD for Mac
- New Screen Magnifier and Reader Offers True Portability
- Lingraphica Updates Its Speech-Generating Device with New Features
- Autism Education and Advocacy Organizations Co-Sponsor Autism Tomorrow, the Complete Guide to Help Your Child Thrive in the Real World

37 28th Annual Conference Information
Subscriptions
$36 per year in the United States. $52 per year to Canada and Mexico (air mail.) All subscriptions from outside the United States must be accompanied by a money order or a check drawn on a U.S. bank and payable in U.S. funds. Purchase orders are accepted from schools or institutions in the United States.

Publication Information
Closing The Gap (ISSN: 0886-1935) is published bi-monthly in February, April, June, August, October and December. Single copies are available for $7.00 (postpaid) for U.S. residents. Add $2.00 for postage outside the U.S. The annual Resource Directory issue sells for $16.95 plus postage and handling. Article reprints available, please contact the Managing Editor for details.

Contact Information
Please address all correspondence to Closing The Gap, P.O. Box 68, Henderson, MN 56044. Telephone 507-248-3294; Fax 507-248-3810. E-mail <info@closingthegap.com>; Web site <www.closingthegap.com>.

Copyright
Entire content is copyright 2010 by Closing The Gap, Inc., all rights reserved. Reproduction in whole or in part without written permission is strictly prohibited.

Editor’s Note
The information provided by Closing The Gap, Inc. in no way serves as an endorsement or guarantee by Closing The Gap, Inc.

Dolores Hagen
Publisher
Budd Hagen
Editor
Connie Kneip
Vice President / General Manager
Megan Turek
Managing Editor / Sales
Jan Latzke
Subscriptions
Sarah Anderson
Administrative Assistant
Becky Hagen
Sales
Marc Hagen
Web Development
It happens towards the end of every school year. I find myself in the back of presentation rooms rather than in the front, where I would be typically lecturing, training on software or coaching staff to implement some AT tool or strategy. Why am I in the back? It’s the best place for a trainer to be – because those that have been the participants for a series of AAC implementation in the classroom workshops spread over five days through the whole school year are now taking their place in the front, presenting their student cases, their hard work, their videos and their data. And they amaze me every year. I can barely hide my excitement (oh yes, and a few tears) as they redeliver the content that I had so hoped would be helpful and meaningful in their classrooms. That’s the culmination of every school year for me since the 1989-90 school year, when I started working at the then Pennsylvania Assistive Device Center that was involved in a research project with Purdue University called Environmental Communication Teaching.

After the four years of formal research concluded, ECT spent the 1990s spreading through most of Pennsylvania’s 29 Intermediate Units through train-the-trainers with PaTTAN, as it’s known now, (http://www.pattan.net/supportingstudents/AssistiveTechnology.aspx), and then to Florida’s FDLRS/ATEN sites (http://www.paec.org/fdlrstech/index.html). ECT made a run in Georgia through a five-year process with the Georgia Department of Education and GPAT (http://www.gpat.org/), and in several school districts, such as Troup County Schools in LaGrange, Georgia. In Ohio, ECT is the communication implementation model used in several schools in the Akron-Canton area. ECT even had a short stint in California’s Mt. Diablo Unified School District. And now ECT is making it’s way through Texas! It actually hasn’t just started in Texas. It’s been a long road, starting with one of the original ECT trainers, Susan McCloskey, who had done training in San Antonio for a large group back in the mid 1990s. Susan is now in Volusia County Florida schools combining ECT training with the SCERTS model to better serve students who are on the autism spectrum (http://blackboard.volusia.k12.fl.us). She presented ECT at ATIA-Orlando and will be doing so again in January 2011 (http://www.atia.org).

Karen Biggerstaff and Paula Gardner did a lot to keep the ECT strategies going in San Antonio area schools. And for several years, I did the ECT training for the Region 20 ESC (http://portal.esc20.net/portal/page/portal/esc20public). We had teams and trainers from nine other school districts. Monica Klein and Kathy Nutt from San Antonio Independent School District use ECT as part of their implementation model for delivering AAC services to students. They’ve presented on it at the Texas Regional TATN conference (http://www.texasat.net/).

Robert Smith brought ECT to Longview, Region 7 ESC (http://www.dshs.state.tx.us/region7/default.shtm) in east Texas and Jill Beall became a trainer who not only does ECT for that region but is starting to train in other Texas ESC areas as well. Starting out with Jill in the train-the-trainers was a team of awesome staff trainers from the St. Louis School in Tyler, Texas. These women had the great task of tying together ECT with Every Move Counts (http://www.everymovecounts.net/) and with some of the instructional strategies that they were using from the Texas School for the Blind (http://www.tsbvi.edu/publications/vmi.htm). Their principal, Karen Hacker, followed through with a school-wide ECT training so that everyone, including the cafeteria staff at the school, understood that communication is important for all students (http://www.tylerisd.org/schools/st_louis/).

ECT IS AS BIG AS TEXAS

THE STORIES AND TIPS OF ENVIRONMENTAL COMMUNICATION TEACHING

By Kelly Fonner, Andrina Hamil, Kenja James Johnson, Debra Stanley, Marguerite Hornèy, Ruth Solis, and Beth Coletta

Joe Morgan, paraprofessional, and Matthew talk about some of his favorite playtime amphibians.
So from the background to current day, through real teams who have worked really hard with real students, we'll try to highlight the strategies through ECT's 5 Tips. And if that's not enough – well, you'll just have to come to one of our presentations somewhere ...  

**ECT TIP #1**

Activities are the Foundation for Communication. Students have to have a purpose to communicate. Yeah, it seems simple. In ECT, we start out with having the classroom staff bring or write down the schedule of their day. One of the biggest errors in why AAC doesn't get implemented in the classroom is that people (staff, parents, representatives) think it's all about the device. What device should I buy? This one must not be the best one ... Lots of excuses are made over devices. Or better yet, we blame the student. What trainers emphasize in the very first hour of ECT is, if you don't have something organized happening in the classroom, who cares what device you have? And for busy teachers in busy programs, someone from the outside cannot plop into their classroom and say “Here, do this because you now have this kid with this device and you now have to fit this new activity into your already busy day because I said so. Goodbye.” It doesn't work that way. Students need to talk about something that is already going on in their classroom. And if nothing is happening in the classroom, consultants have to back up and help staff find meaningful curricular activities, connected to school standards, for students to be engaged. “You gotta have something to talk about.” And that’s what Matthew taught his team ...  

Corpus Christi Independent School District (http://echalkweb.ccisd.us/home) is the largest school system in the Region 2 Education Service Center area (http://www.esc2.net/). That service center has an ECT series of training in April, Matthew demonstrated an increase in independence, the ability to communicate his snack preference and navigate through the symbol location. At the start of the training, he had difficulty remaining in the designated snack area and showed little interest in communicating effectively. Now, he can independently complete the snack activity to request his wants. Early intervention and careful consideration for all aspects of educational needs have proven to be essential in his current success. Through ECT, Matthew was able to learn that his communication attempts could get his needs met, as well as give him the power to direct the actions of others. Matthew’s mother attended the final presentation day and shared with the group that she was giving the ideas from ECT to his speech language pathologist outside of the school program in order for her to move forward with Matthew in his communication strategies. There are great expectations for Matthew’s future.  

**ECT TIP #2**

Build Communication Interaction Skills within a Context. Too many students are introduced to communicating with an AAC system by single interactions. Press a button and say this, and then someone takes your voice away. Wow! What a reward for talking! Just pass my voice on to the next student or put it away so you can bring it out whenever you feel like I’m allowed to talk again. When will that be? Next week? Next time you want to read a book and let me say a word every now and then? I often tell teams “wouldn’t you hit that switch as many times as you could if you didn’t know when you were going to get to talk again?” Sadly, some get it, some don’t. Wonder students don’t learn to initiate. All of their initiation is controlled by access to their device rather than participation in the real communication experience.

Matthew’s target activity was based on developing communication during snack time. The objective was to request a snack, drink, indicate when finished and to clean up. Along the way, the team had to make some changes to the AAC system, from the Springboard to an eight-location Tech Talk, as well as a variety of snack choices.  

After the completion of the ECT series of training in April, Matthew demonstrated an increase in independence, the ability to communicate his snack preference and navigate through the symbol location. At the start of the training, he had difficulty remaining in the designated snack area and showed little interest in communicating effectively. Now, he can independently complete the snack activity to request his wants. Early intervention and careful consideration for all aspects of educational needs have proven to be essential in his current success. Through ECT, Matthew was able to learn that his communication attempts could get his needs met, as well as give him the power to direct the actions of others. Matthew’s mother attended the final presentation day and shared with the group that she was giving the ideas from ECT to his speech language pathologist outside of the school program in order for her to move forward with Matthew in his communication strategies. There are great expectations for Matthew’s future.

In ECT, we build communication interaction through routines, by students experiencing the whole communication interaction, all parts of it, from beginning to end; they learn when it’s their turn to talk and when someone else gets a turn. What if they don’t know what to say? We’ve got supports built in that are set up for teaching the interaction within the natural environment with natural cues; and they are NOT commands, such as “Hit your switch.” (More of this later in ECT Tip #4.) We emphasize that it’s every classroom staff’s responsibility to support and teach communication, not just the person in the speech role.
And in Texas, just as in many other geographical areas, we have multiple language challenges. Students are multilingual coming into school programs and sometimes staff are as well. Now we go to Region 1 Education Service Center area (http://www.esc1.net) and Lizabeth …

Hidalgo ISD in south Texas is a small school district of 3,516 students with 154 students eligible for special education services. Of the total student enrollment in Hidalgo ISD, 99.54 percent are Hispanic and 88.85 percent of the total student enrollment in Hidalgo ISD serves as a port of entry along the U.S.-Mexican border. It is the fourth largest port of entry on the southern U.S. border. The unemployment rate is 9.6 percent and the median income is $22,631 (City of Hidalgo).

The Hidalgo ECT team was comprised of staff who work in or with their self-contained early childhood classroom. Barbara Montalvo is the special education certified Early Childhood teacher, who had the support of teaching assistant Ileana Cuellar. The Speech Language Pathologist, Josie Guzman, worked part-time for Hidalgo. The final supporting team members were two assessment staff, Rosario Nava and Erica Chavez, and Certified Teacher of the Visually Impaired, Nilda Cantu. Josie is an ASHA certified SLP providing services contractually. She was a second day addition to the team after they discovered that they could not participate without an SLP or speech therapist. In January, SLP Assistant Laurisa R. joined the team.

Our focus for this case is Lizabeth, who was 6 years old at the beginning of the 2009 school year and had significant communication challenges. Lizabeth did not initiate any communication and most vocalizations were of protest and discomfort. She was a passive actor in classroom activities; things were done to her rather than with her. When adults interacted with Lizabeth, it was in her home language of Spanish and to give her directions [i.e., Ven aqui (Come here), Es tiempo para la merienda (Get ready for snack.)] Assistive technology was used for communication, but it was hand over hand and messages were focused on teaching nouns and not on communication (Hidalgo Independent School District, 2009).

The team had limited access to the SLP since she worked under contract. But she was with them for the last four ECT training/support days and in the district only when she was not involved with other contracted duties. This team took on the challenge of the ECT training knowing that they would not have the ready support of an SLP and that the SLP herself would not be doing the direct communication instruction. They assumed the responsibility for being the communication partners and the responsible parties for guiding Lizabeth as she learned to be a communicator.

The team members began training as representatives of their individual disciplines and not as communication partners. Through the ECT five-day training process of content presentation, writing and refinement of ABOs, video reviews with feedback and team problem-solving meetings, there was a metamorphosis from individuals who were discipline-focused to a team of students and teachers of communication.

As the team’s knowledge and skills increased, Lizabeth’s skills as a communicator emerged. In the final video documented, Lizabeth demonstrated initiating communication with new people, both adults and peers, taking turns in communication interactions, decreasing vocalizations that indicated discomfort and protest and leading on some classroom activities. In the culmination celebration of the growth of both the team and Lizabeth as communicators, Ileana summarized their ECT journey: “This training changed the way I look at children [with disabilities] as communicators. This training changed me and what I can do to teach a child how to communicate. It taught me things I can use with my own child. I will always be grateful for this opportunity.”

Thus ends Part One; In Part Two, we will pick up with more examples and school teams to highlight ECT Tip #3 – Environmental Strategies with Laura, Savannah, and Jennifer. Jonny’s story will tell you all about ECT Tip #4 – Prompting Hierarchies and Jose will just warm your heart, as he does all of us, with EC Tip #5 – Activity Based Objectives. We will also have some interesting links to supporting documents on the Closing The Gap Web site. So join us in the next issue …

REFERENCES


ABOUT THE AUTHORS

Kelly Fonner, M.S.Ed., is an Educational and Assistive Technology Consultant. www.kellyfonner.com

Andrina M. Hamil is an Elementary Adaptive Education Program Coach for the Corpus Christi Independent School District.

Kenja James Johnson is a Music Therapy Specialist for the Corpus Christi Independent School District.

Debra Stanley is a Secondary Adaptive Education Program Coach for the Corpus Christi Independent School District.

Beth Coletta, M.A., CCC-SLP, is an Assistive Technology Specialist for the North East Independent School District.

Marguerite Horney, M.Ed., is an Assistive Technology Specialist for Region 1 Education Service Center.

Ruth Solis is a Speech Language Pathologist for Region 1 Education Service Center.
INTRODUCTION

How do you feel about the low tech communication systems you are developing? Are your clients able to communicate efficiently and effectively? Can they question and comment or stay connected to the conversation? For most of us who are responsible for creating communication systems, these questions haunt us daily. Did you ever consider why your clients are not using their communication systems for functional or interactive communication? You may feel confident that their physical access is appropriate, but do you feel as confident about the vocabulary? How do you determine which words are the most essential for your client?

After attending a session presented by Bruce Baker, founder and president of Semantic Compaction Systems, at an American Speech and Language Hearing Association Convention, the assistive technology staff of Baltimore County Public Schools reconsidered and revamped their process of vocabulary selection. This new process proved to be successful, opening the doors to functional and interactive communication. We have seen a significant difference in student access to and use of the new format since its inception. Teachers are motivated to make these low tech systems available because they are witnessing spontaneous and independent communication by their student users.

BACKGROUND

In the past, regardless of the type of communication tool that was provided, whether a communication display, a communication book or a speech-generating device, many users were significantly limited in what they were able to say. This constraint was largely the result of the vocabulary words that were chosen for inclusion. Word arrays frequently focused on specific tasks or activities or were dependent upon the environment. Another characteristic was that these words were predominantly comprised of nouns.

Opportunities for communication were routinely limited to choice making or to the “show me” situation, where students are asked to show the facilitator the location of named items. Regrettably, asking our users for a show me type of response is not supportive of functional, generative or interactive communication. The same can be said of words linked with choice making. Consider vocabulary associated with mealtimes, such as the names of foods, drinks and required utensils, or vocabulary associated with trips out in the community, such as the names of modes of transportation, stores or denominations of...
money. When words of this type comprise a significant number of the words available, our alternative communication users are unable to express a wider range of language functions.

When considering language usage, we want to be assured that our users will be able to express themselves meaningfully and to take advantage of language structures consistent with normal language usage. Roger Brown (Brown, 1973) identified stages of language acquisition that necessitate the availability of vocabulary that expands beyond simple noun usage. We need to expect our users to be able to comment, direct others, make requests, show possession, reject, and note cessation, along with a variety of other language functions. This is simply not possible when nouns dominate the vocabulary.

Of necessity, we must provide words that offer flexibility to express a wide range of communication functions while allowing our users to formulate spontaneous and novel utterances. Extensive research has shown that these words are relatively few in number. Studies of spoken language, whether elicited or spontaneously generated, have shown that the 100 most frequently spoken words in the English language can account for more than 60 percent of the total words communicated over the course of one's lifetime.

When the net is thrown wider to include a few hundred of these most commonly spoken words, speakers have the potential of saying as much as 80 percent of all the vocabulary that is needed for their communication purposes. Rather than the expected nouns, these specified words are made up of pronouns, determiners, adverbs, verbs, prepositions, conjunctions and articles.

Spoken language studies have also looked at age groups, such as toddlers, adolescents and adults, while other studies have focused on specific environments or the cognitive level of functioning of their subjects. Results remain the same. All studies reveal a consistent and high frequency use of a core vocabulary.

If we, as providers/facilitators/supporters of augmentative and alternative communication systems, provide our users with access to this core vocabulary, we will have gone a long way towards supporting the basis of effective and purposeful communication that will be relevant over the course of our users' lifetimes. When core vocabulary is limited or lacking, our AAC users' ability to express themselves will be sorely compromised.

**APPLICATION**

Based on this reservoir of research, we know that by utilizing this select core of vocabulary, we will provide our clients with opportunities to create functional, interactive and generative utterances. We also know that we will be providing the foundation for a vocabulary that will serve our users across environments and through adulthood.

As we, in our school district, embraced this research, we modified the way we provide and display vocabulary for our users. As a result, we believe we have made a direct and positive impact on the ability of our students to communicate at school, home and in the community. Each of the communication systems that we have provided also takes into account the individual needs of our students.

Our static core vocabulary displays can have as many as 32 to 64 cells, depending on our students' needs. (See photo one) There are a number of reasons that support the decision to include a larger quantity of cells than one might ordinarily consider.

Having more vocabulary than the user can reasonably be expected to use independently provides opportunities for the facilitator to model the use of new vocabulary. Routinely modeling new words or ones not yet in the users' expressive lexicon will facilitate the acquisition and use of new vocabulary. Incorporating new words into one's expressive language is dependent upon the ongoing exposure to use of that word by others. (See photo two)

When there are a larger number of cells on a display, some of the cells can remain empty. This intentional provision of empty spaces accommodates the future addition of words to the display. Previously, the frequent need to add additional words has necessitated the creation of new displays and a reformulation of where words are located on that display. If you initially start with more cells than are immediately needed, you can avoid the complication of having to create a new display. It also has the more important benefit of avoiding the need of a user to visually search for a known icon in a new location.

Another consideration for using a larger number of cells supports the permanent placement of vocabulary in designated locations. Taking advantage of motor planning provides an additional avenue for supporting effective and meaningful communication and is supported by neurological and motor learning principles.

When selecting vocabulary for communication displays, it is also helpful to be mindful of words that have multiple meanings. The
meanings of these words are dependent upon the context of the communication exchange. For example, words like it, go, and turn can take on a number of different meanings. Once you include it, you can avoid the inclusion of a wide range of implicit nouns. The word turn can be used to express my turn, turn on, turn around, turn over and turn here, among others, and some examples of the use of go might include go away, go here, go on, I go and go for it.

**OUR COMMUNICATION BOOKS**

In our school district, we have developed a variety of styles of communication books that are based upon the consistent implementation of research-based vocabulary selection. These books showcase a core lexicon while they also provide readily accessible fringe vocabulary. Fringe words are those auxiliary words that are specific to a topic or situation. While important, they are used with less frequency than our core vocabulary. (See sample worksheet)

In our communication books, core vocabulary is consistently visible, while the fringe vocabulary pages may be flipped to access relevant topic words. (See photo two) Fringe pages accommodate words consisting of nouns, verbs and adjectives that are directly related to the topic or environment at hand. Spontaneous and novel utterance generation (S.N.U.G.) is supported when core vocabulary is used independently or in conjunction with fringe vocabulary.

The use of an existing format makes the development of new communication books easier for staff as well as families. In each format, we have developed a hierarchy of four levels of core vocabulary. The first level includes a limited number of core vocabulary words. Each subsequent level adds additional core vocabulary words to the display. This allows us a great deal of flexibility in determining a good starting point for each of our users, while still providing room for expansion. The ability to select from a predetermined set of words and a variety of preset communication displays allows even the novice to create a functional and interactive system. (Photos Three and Four)

**CONCLUSION**

Success can be enhanced if we “keep it real” in selecting vocabulary that represents the language of students’ peers. We suggest a format that focuses on the language of typically developing peers to determine what vocabulary is needed for the client’s communication system. Utilizing the language of a typical peer provides an avenue for developing a communication system facilitating the full range of language functions.

The next step toward successful integration involves immersing the environment in the alternative language system. The importance of modeling a language system is seen in the development of all children, regardless of their abilities. We automatically speak to the normally developing child, modeling all of the functions of communication as we talk to them. It is our expectation that by providing these children with a model, they too will learn to use speech to communicate. Unfortunately, for students who require an augmentative system, the adults in the environment typically use speech to communicate. The adults do not think to use the communication system that the child is expected to use. This puts our alternative communication users at a clear disadvantage. It is strongly recommended that family, peers and staff, among others in the environment, become versed in the alternative system, using it in conjunction with speech. This method has proven to facilitate the successful integration of the augmentative communication system.

Since we have integrated this process, we have seen a significant improvement in our students’ ability to communicate efficiently and effectively while expressing a wide range of language functions.

**REFERENCES**


Cannon, Barbara. (unknown). A Few Good Words: Why Core Vocabulary is Needed to Enhance Communication in Non-verbal Students.

George Mason University http://at4kids.wikispaces.com/file/view/A+Few+Good+Words.pdf


Baker, Musselwhite, Kwasniewski, (1999). Literacy, Language, and Minspeak™: Core Vocabulary is the Key, Duke University Medical Center, Durham, North Carolina.

**CONTACT INFORMATION**

Marsye Kaplan, mkaplan@bcps.org
Deborah Gerson dgerson@bcps.org
Product Feature

The Intel Reader and Jenny Smith

The Untypical Typical Teenager

Before the Intel Reader, Jenny Smith kept dyslexia at home. Now that she uses the Intel Reader to read a book in a day instead of in weeks, Jenny’s confidence has gone up. Instead of keeping dyslexia at home, Jenny gives speeches about dyslexia, including a presentation to her school, where most people had no idea that she had a learning disability.

Though she laughingly dismisses her love of the Twilight books as just being a teenage girl, DeWitt, Michigan’s Jenny Smith is anything but typical. This 16-year-old is a black belt in taekwondo, a certified scuba diver, a 4.0 student and a published author.

Jenny rattles off a list of her favorite books, including a few fantasy titles, My Sister’s Keeper by Jodi Picoult, and Harper Lee’s classic To Kill a Mockingbird, then pauses. “There are just too many to count.”

Seven years ago, Jenny couldn’t read at all. Simple words like “the” seemed familiar one day, then indecipherable the next. At a sleepover, a friend offered her a book to read, then took it back.

“She said, ‘oh yeah, you can’t read,’” Jenny recalls, a trace of the old discomfort still fresh in her voice. “Reading would have been the best thing ever.”

Though Jenny was clearly having problems reading, a pediatrician dismissed dyslexia, telling Jenny’s mom, Anita, that Jenny just wasn’t as fast as other kids. The family had no history of dyslexia.

“I tried everything. Hooked on Phonics*, using my arms to trace words in the air. One day I could read a whole book, the next day, I’d forget every-thing,” Jenny says. Anita read books out loud so Jenny could memorize them before a reading comprehension class.

A Diagnosis Brings Relief

For Jenny, relief came when her keyboarding teacher saw classic signs of dyslexia. Anita quickly began the process of having Jenny tested and officially identified as having dyslexia. Every week, for the next three years, mother and daughter drove an hour each way to Jenny’s reading lessons.

Two years into the process of learning to read, Jenny began to write the journals that eleven different editors would help turn into her book, Dyslexia Wonders. “The grammar was horrendous, but the words were legible,” Jenny remembers.

TECHNOLOGY BRINGS INDEPENDENCE

In 2009 Jenny won the Remy Johnston Award of Merit for her leadership and service to the dyslexia community. She traveled to Florida to accept her award at the International Dyslexia Association’s annual conference. Part of her award was the Intel Reader.

“I thought, ‘Yes! I don’t have to struggle through my AP History book!’” Jenny says. Her AP History class covers 11,000 pages of text. Before the Intel Reader, Jenny would go to bed at 1 a.m. on school nights, after studying AP History alone for five hours.

In fact, it was her four-inch-thick AP History book that Jenny first used to test the Intel Reader. Intel promised that the Intel Reader would cut down her homework time. She handed them the book. They handed her the Intel Reader full of images of her history text. That day, she sat down with the Intel Reader and finished her homework in 2.5 hours.
“MY LIFE ISN’T RULED BY HOMEWORK,” JENNY SAYS. SHE USES THE INTEL READER FOR SCHOOL, PLEASURE READING, AND TO THE DELIGHT OF ENGLISH TEACHERS EVERYWHERE, JENNY USES IT TO READ HER OWN PAPERS BACK FOR EXTRA PROOFREADING.

HULA HOOPING AND HOMEWORK

After years of memorizing books read to her, Jenny’s ear is tuned to memorize text as soon as she hears it. She does her homework with the Intel Reader while hula-hooping or jogging in place with her Wii Fit.

Anita notices Jenny is able to spend more quality time with the family. “She eats meals with us and she’s not so zoned out from hours of homework.” After using the Intel Reader, Jenny is talking more to her peers about her own learning disability.

At a recent speech in Ohio, Jenny faced a crowd of fifty parents and their children, many of whom were dragged to the meeting by their parents. A boy sat with his hood up, and a girl spent the first part of the speech with her hands on her face, embarrassed to be identified as someone with a learning disorder.

By the end of the speech, all of the kids clamored to try out the Intel Reader. Jenny gave them basic instructions and they were able to use it instantly. “Teachers are amazed. Parents and kids think it’s something they could use. It’s a cool technology,” Anita says.

THE INTEL READER GETS IT PITCH PERFECT

When she’s not working out and doing homework, Jenny reads the words as the Intel Reader says them. “The double voice reaffirms the information coming in,” she says.

Hearing and seeing words as the Intel Reader reads them back also helps Jenny’s speed. “I read a book in a day, instead of in weeks.”

Anita has noticed Jenny’s confidence go up. “She can read longer, stronger and faster,” Anita says.

Recently, Jenny’s dad, who never enjoyed reading, was diagnosed with dyslexia. “When we have some downtime, I could see the two of them sharing the Intel Reader. Father and daughter – dual headsets,” says Anita. But until that break in her homework, Jenny keeps the Intel Reader close by in her backpack or with her Intel Portable Capture Station, which she uses to efficiently capture large amounts of text.

Jenny uses her Intel Reader to devour books she downloads from bookshare.org and books she checks out from the library, but there’s one book that sounds particularly sweet to her ears – her own. She couldn’t face reading her words in print after reading them so many times through the editorial process, so she picked up her Intel Reader. “The book sounds how it’s supposed to – perfect.”

To learn more about the Intel Reader, visit reader.intel.com, and to find out what other users are saying, join our community at experiencereader.com.
A child struggles, on her way to “melting down” in a small classroom in Wisconsin. Her special education teacher doesn’t even pause to take a breath while pushing the button on the remote control that starts “MeMoves.” The young girl stops and turns to face the video monitor. Calmed, she begins to quietly follow the movements that she sees on the screen.

Cheryl Oakes says she was mesmerized when she first saw MeMoves. Content Coach for Technology K-12 in Wells, Maine, Cheryl was named Teacher of the Year by ACTEM (Association of Computer Technology Educators of Maine.) A big fan, she purchased some for her school and has shared it with others. “For us it has really been transformational!”

Brian Dowd is the AT Consultant in Alton, Illinois. He began to use MeMoves as soon as it was launched in January 2010. “The transformation in our classrooms has been amazing. The students ask for MeMoves! The immediate peace that transforms the room is something that has to be seen and experienced. We are using it in pre-k through 3rd grade and even in some low incidence middle school classes.”

If Karen Abbott forgets to use MeMoves, her first graders remind her. She calls it “A great transition tool. Kids are taking ownership of it. We do one or two sequences and everything in the classroom changes.” Her entire first grade class in Cape Elizabeth, Maine enjoys doing MeMoves each day because it helps them to feel calmer and pay attention more easily. An added benefit is that the occupational therapist uses MeMoves as a way to help children with ASD and other special needs.

Similar experiences are taking place in classrooms around the country as teachers and therapists use MeMoves to increase calm, focus and attention. Although it was developed for children with special needs, it doesn’t look anything like a special education product, and kids like that. The Result? MeMoves can be used easily and deliver big rewards for therapists, regular classroom teachers, parents and caregivers.

“MeMoves is a DVD containing 13 sequences of images and movements set to music. Users choose a sequence and imitate

By Roberta Scherf

Product Feature

MeMoves:
A Game Changer in the Classroom and at Home
the movements they see on the screen, doing their best to keep time to the music. A kind of American musical t’ai chi or yoga, MeMoves uses familiar geometric shapes to create movements that focus and calm. MeMoves requires no special instruction, training or knowledge. The people on screen are all shapes, sizes, colors and ages—from just under 2 years old to just over 90 years old. Doing the movements (body puzzles) simultaneously engages the auditory, visual, motor planning and sequencing, and limbic parts of the brain; but kids just know they are fun.

MeMoves also includes a music CD and textured Puzzle Cards. The CD contains all of the songs featured on the DVD; and the Puzzle Cards include the shapes found on the DVD, allowing users to perform similar puzzles anywhere, without the need of a DVD player. A newly released MeMoves app for the iPhone/iPad/iPod touch is now available on iTunes.

As one of the parents involved in building a local Montessori school, I was an active participant in my children’s early education. While my oldest son sailed through effortlessly, my daughter struggled with each moment. Each day was like the movie “Groundhog Day,” except it wasn’t all funny. Whatever she would learn one day would be gone by the next. Socially she struggled to interact with the other children. When they moved on to full days, her teacher continued to limit her to half days and she often left the school in tears, sobbing, frustrated by her isolation.

By 1997 I had spent five years struggling with my daughter who was here, but not here. Often delightful, always unknowable, I believed if I could just find the right key, it would unlock the bright and curious little girl I knew was trapped inside. None of the terms used to describe her – sensory integration disorder, autism spectrum, tactile defensiveness, alpha child, pre-dyslexic – meant anything to me at the time except “different.”

I was as frustrated as she was; but I obsessed, read, took classes and studied, trying to learn something that would make everything better or at least okay. It started with Norman Weinberger’s “Musica” research notes site from UC, Irvine, and made its way to Phyllis Weikart’s work on rhythmicity at the University of Michigan and Hi/Scope. As I continued to explore the relationships between mind, body, music, movement and learning, bits of the puzzle started to fit.

I combined everything into a kind of dance that Rowan and I did together for a few minutes, every morning and every night. This primitive version of MeMoves changed both of our lives. One month later, my daughter, who couldn’t remember a single letter for more than a day, was reading sentences, then chapter books, making eye contact and asking to be held.

I realized that if one child could benefit from this, others might, as well.

My autistic son only saw the video once – for just about 15 minutes – as soon as he heard the music, his attention was captured. After only a minute or so, he started doing the moves. There were about six adults in the room – we were completely silent. Every few seconds he would look at me, so I started to do the moves and everyone else followed. It sounds crazy, but I could see his body relax and his breathing slow! - Mandy O’Brien, Parent Waupaca WI.

MeMoves is different. An intervention rather than a therapy, MeMoves focuses on the emotional state of the child, rather than any specific behavioral outcome. At its core is the belief that a calmed and centered child (especially one with special needs) will be able to learn more easily and express themselves more clearly and directly. Each MeMoves sequence takes only two to three minutes, yet immediately and measurably improves the efficacy of any subsequent activity.

We all know how difficult it is to perform under stress. Everyday activities, such as remembering where we put the car keys, or communicating effectively with family or co-workers, becomes increasingly difficult as our stress and anxiety levels rise. Imagine your most stressful day(s), and consider this the “everyday” level or “baseline” for many of those with ASD and special needs.

In her many books and presentations, Temple Grandin talks about how the constant alert state and hyper vigilance of those with autism is similar to that of prey animals. Constantly scanning the environment, anxious, on edge, she clearly demonstrates how the baseline for those with autism is significantly different from other people.

MeMoves shifts the baseline, reducing this hyper aware state as it focuses the users’ senses on a singular activity. MeMoves fully engages and calms, filtering out overwhelming external stimuli, helping each child to become integrated and navigate more effortlessly through their world.

I received a note from school today mentioning that our son (who has very limited verbal skills) looked at the teacher and spontaneously requested, “I want MeMoves”. Thanks for such a great product. – Mary Hansen, Parent, WI

The creation of MeMoves was very intentional. Nothing in MeMoves is random; everything, from the colors on the box to the shapes of the icons, to the unique music and the people on the screen, is purposeful and based on years of development and testing with parents, teachers, and therapists.

Although used extensively in schools and therapy centers, MeMoves was origi-
Finally designed for home use. We wanted MeMoves to be accessible to parents and grandparents struggling to reach their special needs child, searching for an intervention that was effective, fun and affordable. One aspect of MeMoves that is often overlooked is its intergenerational nature. It encourages participation by the entire family, not just those with special needs. This group participation removes any stigma associated with a “special needs” product, allows for much greater compliance, and as a result, provides calm and focus to everyone.

At home, MeMoves is used as a “quiet down” activity before bed, before homework, prior to doctor visits and therapy sessions or whenever anxiety is present. Many parents use MeMoves in the car as a two to five minute activity while running errands.

We LOVE LOVE LOVE MeMoves!!!! I use it with students with autism and it is fantastic for calming and focusing my students before transitions or work times! - Tara Livermore Tuchel, OT, Willow River Elementary, Hudson WI

We designed MeMoves to be effortless to implement in the classroom. One sequence can be started in as little as 10 seconds and needs no classroom reconfiguration. MeMoves requires no special knowledge, instruction or training on the part of the teacher or therapist.

Most classrooms use MeMoves two to three times a day; one to three sequences at a time. A transition tool, MeMoves is often used at the start of the classroom day, after lunch and recess, before teaching a new or difficult concept, before testing and before quiet activities. MeMoves is used in special education and regular classrooms equally, removing any label or stigma often associated with activities specific for those with special needs.

MeMoves is based on existing research into embodied cognition, rhythmicity and the impact that music and movement have on learning. Ongoing studies evaluating its efficacy are just beginning, but the results are very promising.

Dr. Patricia Leigh presented her research at the International Meeting for Autism Research. (http://imfar.confex.com/imfar/2010/webprogram/Paper5861.html) Her objective was to examine whether extended use of MeMoves would activate mirror neurons, ultimately leading to increased imitative and social functioning. A 5-year-old boy with ASD performed MeMoves five minutes a day, five days a week over a 12-week period. An EEG was taken before and after the 12-week period to establish changes in brain wave functioning. Also, behavioral variables (eye contact and imitative behavior) were examined at regular intervals throughout the testing protocol. Her paper described improved behavioral outcomes and mirror neuron functioning, suggesting that MeMoves is a fun and engaging interactive therapy that families can do at home together.

A recent study conducted by graduate students at the College of Saint Elizabeth (under Brian Freidlander’s tutelage) analyzed the use of MeMoves by four students with ASD and found a clear increase in positive social interaction, as well as a decrease in undesirable behaviors due to an ability to communicate wants and needs more effectively.

As MeMoves’ use grows, we look forward to research collaborations with multiple therapy centers and universities to better understand the mechanisms and facets of MeMoves’ efficacy.

MeMoves was recently awarded a Parents’ Choice Gold Award. Claire Green, Executive Director, wrote: “MeMoves has become a game changer in many homes … we can refer to words that families have used to describe MeMoves; words that include calming, transforming, unprecedented focus, accomplishment and magical … Fascinating, captivating and utterly absorbing, this simply elegant production of movement and music is devoid of bells and whistles and loaded with wisdom and clarity. Narration is neither needed, nor present. MeMoves is a treasure." As rewarding as that is, the real joy comes from the continued e-mails of parents and teachers sharing stories about the ways that MeMoves is changing and improving the lives of the children in their care.

MeMoves is only available online at www.thinkingmoves.com. It retails for $59.95 and includes the MeMoves DVD, music CD and textured Puzzle Cards. If using a purchase order, fax the PO to 715-246-4366. MeMoves is the creation of Thinking Moves LLC, located at 243 Plainview Dr. River Falls, WI.

For more information, contact Chris Bye (chris@thinkingmoves.com) or Roberta Scherf (Roberta@thinkingmoves.com), or call us at 715-377-9827.
Access to print material can be hampered by various conditions, including sensory and organic disabilities. With the advent of computer and electronic technologies, it has become possible to convert paper-based information into digital and audio formats. The increasing number of textbooks is offered on disks and online. Unfortunately, despite a modern delivery method, information rendered digitally does not always follow accessibility standards to meet the needs of learners with print disabilities. This article presents several examples of textbooks published in the electronic formats that lack features needed to regard the title accessible. The readers will also learn about features and options that are necessary to create an electronic textbook that could become a viable tool in the inclusive setting. Several examples and initiatives that support readers with print disabilities are also presented.

Access to information, including print information, is one of the fundamental notions needed to function effectively in today's world. It could be assumed that the Internet, with multimedia presentation of information, sufficiently complements traditional sources of print material.

Education taps into the fathomless repository of online resources to enhance and make the learning process more attractive. Because of the inclusive nature of educational models, it is necessary to ensure the provision of learning materials in accessible formats. The re-authorization of IDEAIA from 2004 mandates that students with print disabilities receive their textbooks in appropriate format in a timely manner. Section 613(a)(6) of State Eligibility reads that "a local educational agency that chooses to coordinate with the National Instructional Materials Access Center, when purchasing print instructional materials, shall acquire the print instructional materials in the same manner" (NIMAS, 2004). As part of this law, National Instructional Material Accessibility Standards have been designed and publishers of textbooks have been obligated to submit electronic versions of their publications to the central repository called National Instructional Material Accessibility Center, or NIMAC.

Although the participation in NIMAS is optional, most states have elected to retrieve data from the NIMAC that is the central repository of the electronically stored books. Due to complexities of copyright laws, the implementation of NIMAS requires that specific procedures be followed.

The virtualization of classroom resources is inevitable and it is only a matter of time until the majority of school supplies will be acquired through cloud computing. Cloud computing services are provided through online applications and are stored remotely and independent of the end user’s location. Businesses use this type of delivery because of its cost-effectiveness. Educational institutions that seek less expensive and more technologically advanced alternatives are also increasingly intrigued by the Web-based educational materials. In addition to its multisensory presentations, online material lends itself to accessibility features, either through ones that are inherently built into operating systems or third party support software. The above would indicate that sufficient and effective technology is readily available to yield educational material accessible for students with a wide range of special needs. The reality turns out not to be so optimistic and the implementation of flexible learning material has to surmount numerous roadblocks.

Alternative and specialized formats, those in electronic mode in particular, can offer a wide scope of accessibility options. Not only do they provide physical and sensory access to the material, but also assist in processing and comprehending information. It means that accessible electronic textbooks need to consider all the aspects of interaction.

E-books are electronic forms of printed material. In most cases they are composed of three components: digital text, reading software, and hardware on which the book is played back (Cavanaugh, 2002). However, electronically presented texts go beyond mere digitization of the information. E-text offers wider variety of interaction than print material. Because larger numbers of students with moderate to severe disabilities access the literacy world, more versatile literacy tools to support their comprehension emerge (Karen & Ayers, 2009). Electronic texts can be enhanced additionally by auditory and visual supports.

When creating textbooks, the whole slew of experts, ranging from authors, artists and publishing staff, collaborate to ensure the quality of the final product. Since such great resources are employed at this stage, it would be advisable to take accessibility into consideration at this time. A mere digitization does not make text fully accessible. It is unfortunate that many publishers provide products that meet only the minimum legal requirement for accessibility. Accessibility begins with standardized and open formats that will not limit third party
access software from reading and navigating text.

**ONLINE OR CD-BASED TEXTBOOKS**

Prior to the adoption of NIMAS policies, textbook publishers began to offer their publications in electronic versions – either Web-based or CD-based. The advantage of online textbooks is that it can be accessed from anywhere for as long as the student has an Internet connection. Besides, an online version does not have to be carried in the backpack, making one much lighter. CD-versions, although they need to be physically transported between home and school, do not add too much weight to the school bag. What is more, students who do not have Internet at home can still read the book on their computers.

Unlike NIMAS that is governed by rules and regulations in regards to the technical standards and parameters, other electronic versions depend solely on the publishers’ concept of a digitally rendered textbook. There are no official guidelines that the publishers are required to follow, which has its ramifications. There is no comprehensive manual that describes technicalities of a fully accessible textbook.

Individuals can directly contact publishers to request alternate formats. NIMAS is supposed to ascertain availability of XML format by submitting it to NIMAC repository. However, some may want to shortcut the NIMAS process and work directly with publishers on receiving alternate text rendition. Association of American Publishers Website (Publisher Lookup Service) can be a helpful tool in this undertaking. The site lists scores of publishing houses and their contact information. The drawback of this list is that despite a respectable number of publishers, some districts will not find the ones they may have picked to adopt their textbooks.

There was an outlook for equal access with the advent of digital versions of textbooks. The expectations have been high; unfortunately the production has not been entirely satisfying. Publishers, either because of the protection of copyrights or other policies, created image-based online textbooks with basic page-by-page navigation.

The author has studied a number of titles from different publishers available online to find out what accessibility features are included. Publishers vary in their offer. There are texts whose difference between paperback and digital version is only the format in which it is presented. Otherwise nearly no accessibility is included. Students with some physical limitations might appreciate such format, though. If handling a paper book is too challenging or even impossible, they might be able to use the computer mouse or other adapted input devices to navigate through the pages.

A dubious honor of an inaccessible online presentation could be rewarded to Holt Online edition of a known Science and Technology Series. The whole series is available online for the subscribers who, having logged on, are taken to a page with a list of links leading to specific parts of the book series. Once the students are linked to the selected title, they are supposed to choose the chapter and the section they want to read. Both of these selections are done through dropdown menus. Up to this point, all the navigation and controls are fairly accessible. Even blind students who need to rely on a screen reading program can make those steps independently with little or no prior run through. However, when the required choices have been administered, and the first page of the section appears in the central portion of the screen, accessibility for many users ends. The pages are presented as static images. (See Figure 1) Good readers who may require some level of magnification can be accommodated by the use of third party screen magnifying software or magnification options in the Internet browser. Mere increase in the print size, however, will not put them on a par with sighted peers when it comes to the reading speed due to visual field loss, problems with fixating or other oculomotor issues (Bernard, et al., 2008).

McDougal Littell went a step further in their attempt of making their product more accessible. At the top of the book window, users can find two links, Accessible TOC and Accessible Page. The former opens a new window with a Table of Contents in the form of hyperlinks. The page is created using a simple HTML code, making it accessible for various text-to-speech solutions. When the student finds the desired page, they click on a link to open a page from the book in no other format but pdf. Similar to the above example, various strategies need to be implemented in order to make the text at least “audible.”

Let us imagine students who are already struggling with different aspects of learning, who are frustrated that, unlike non-disabled students, they cannot simply open a book, read it and comprehend what is printed there.
Their teachers, hopefully knowing of electronic versions, may presume that e-text will resolve issues with access to information. They would happily hand in either a CD or a password to an online copy of the textbook and expect students to read and understand. In the case of McDougall Littell, the word accessible is, at least, misleading. Although pages are in a potentially audible format, the actual functionality can be questioned.

Access to graphical information, tables, complex mathematical equations, graphs, and the like is not entirely solved either. In fact, it causes even bigger problems. The first solutions to read math sentences are available, yet they are not incorporated entirely into NIMAS. Only a very limited number of tools is available to handle more complex numerical information. Images are not always explained, described or even tagged to assist visually impaired students in understanding their contents and significance. At the time of writing, gh player and Dolphin Easy Reader software were offering the best options to tackle mathematical expressions. Hopefully, more can be expected to be released.

The major problems with math expressions in many of the current online and CD-based textbooks, is their format. Unlike text, math is presented in the format of static images. These cannot be read by screen reading programs or other text-to-speech software options. They also allow for very limited visual adjustments to meet needs of users with visual impairments (MathML).

One of the more promising projects on accessible textbooks is done in Greece, where scientists from the Foundation for Research and Technology – HELLAS – designed and created a dual-user interface digital text reader. The reader, called Starlight, offers numerous accessibility options and functionalities, equipping visual and non-visual users with a powerful reading tool (Grammenos et al., 2007).

**IDEAL ACCESSIBLE TEXTBOOK**

There are many components of an accessible textbook that could be offered to any student, regardless of their abilities, disabilities, learning styles, or backgrounds. Electronic formats have a potential of becoming universal due to their flexibility. Features, like voice output, dictionaries, note taking, adjustable appearance, (Karen & Ayers, 2009) may include all the learners. Connaway lists numerous advantages of e-books. Some of them are easy access to content, search capabilities and linking to external resources.

Apart from features that are more commonly associated with alternate or accessible formats, like color and size adjustments, text-to-speech or keyboard navigability, less known options are needed to accommodate a wider range of students. For example, students with severe hearing impairments, whose first language is sign language, would greatly benefit from having Signing Avatars concatenated to the print text. Students with cognitive challenges might find it easier to access and comprehend text in alternate format combined with adjustable displays. The function of adjustable display is to block out fringe information, emphasizing only the information that is crucial.

**LOOKING FOR SOLUTIONS**

One of the more common methods of acquiring digital text is scanning. Despite constantly improving OCR technologies, scanning is a tedious process that is prone to errors and omissions. According to Skip Stahl, this form of material production has been embraced by special educators to meet their students’ reading needs and the federal mandates that obligate schools to provide accessible formats in a timely manner. He, however, admits that such manufacturing may result in questionable quality and usability.

GDL project (Dawson & McCulloch, 2006) also proved that the methodology that requires optical character recognition can be cumbersome. In case of non-linear text with unusual granularity or information arrangement, additional operations to align imaged text may be necessary to improve text recognition.
Despite the growing quality of scanning devices, only high end tools can guarantee high level of output. The cost of such solutions can, however, be prohibitive for small-circulation producers.

Scanning is thought to be not only imperfect but also requires equipment that is barely portable. Two devices, Intel Reader and KNFB Reader have been designed to give potential users independence from desktop computers and stationary devices. Both units work on the same principle. They take a snapshot of a page and instantaneously conduct optical character recognition to have the text read by built-in synthetic voices. It can be argued whether this format makes a textbook accessible but, at minimum, a student with print disability gets an audio output and can "read" the content.

The process is somewhat similar to scanning, however, due to the size of any of the two gadgets, students are not confined to workstations with scanners.

Bookshare and RFBD have been established to create digitally rendered books for people who are print disabled. Both services are paid services for an average person, but some will qualify for free options thanks to federal grants that were awarded for the two organizations.

Although they both produce texts in DAISY format, their products have significant differences. Bookshare has chosen to create electronic text versions that require TTS software to be read. The books offered by RFBD are audio based with digitally recorded text read by a human. Either format has its proponents and opponents because they have specific advantages and disadvantages. End users can only celebrate that those two organizations exist because they have wider variety of texts to choose from.

Synthetic speech, despite its growing quality, is still considered inferior to human voice. It is less natural, less expressive and more monotonous. People who are not accustomed to it are particularly resistant to making it their first choice. Elderly people are also more likely to swing towards a human voice.

Nonetheless, electronic text paired up with a synthetic voice has its benefits. First of all, having more than one high quality voice installed on the reading device, the user can switch between the voices. For example, if the reader decides that a female voice fits the content of the book better, they can select one that will create better ambiance. Electronic text itself allows for certain alterations to match the reader’s visual needs.

Audio-based DAISY formats usually omit the visual portion of the publication. Naturally, if needed, the user can open a physical book and follow the text visually while listening to the audio, but paper cannot be so easily modified if it is necessary. Besides, the reader is dealing with two items, the audio device and the book.

Regardless of their shortcomings, both Bookshare and RFBD can be appreciated for their contribution to the audio and electronic book market. Without their offers, many readers could be left without access to many important publications.

**SIMPLIFICATION OF INTERFACE**

With XML and DAISY becoming commonly accepted as the most accessible and flexible formats, new publications geared towards K-12 and college students should be designed to meet the accessibility standards. The creation of a simple HTML page with links to separate pages so that students can quickly navigate from one accessible page to another page is one of the most fundamental solutions. Authors and publishers have every right to protect their copyrights. No sign of violation can be tolerated because it leads away from making the book...
products more accessible. And yet only few publishers, like Pearson, readily convert to the group of believers that access to information is a birthright in today’s world. HTML is the language that is text based and, as such, is welcoming for synthetic speech. Pearson published a series of texts in this very format wanting to help struggling K-12 students. Hopefully their initiative will find more followers who will be more eager to design accessible publications.

Electronic format is a big step towards accessibility. Technology is not a barrier anymore. Even though the fight for good quality electronic versions is not over yet, another important aspect of accessibility needs to be discussed. TTS that reads encoded letters, words and other characters does not understand the context. It will not pause or add some other emphasis unless there is a character that will indicate a change in reading. TTS will follow only the linear, two-dimensional order. What is visually logical does not have to be logical for the synthetic voice. Ken Grisham of Premier Technologies during one of his training sessions, presented a simple example of how changes in the layout can improve the speech output. Multiple choice tests provide the doer with several options for the answer. The layout of those choices will determine how they are read by TTS or other screen reading solutions. Text-to-speech pauses after some punctuation marks, like a period or comma. It will not pause when there are several blank spaces between words. It means that a thoughtful text formatting is needed for the synthesis to read it correctly. Poor layout will be accessible for the TTS but it might be hard to follow by the reader.

Another important aspect of designing accessible texts is the clear and consistent navigation within a page. Learners or readers with severe visual impairments will be particularly thankful for a logical arrangement of text, graphics and charts on the page. Some form of hidden text support could inform the reader about the number and possibly the positioning of different elements. Navisio project, developed in France in 2008, proposes color-coding of paragraphs or other elements of the page to inform the reader which portion has been read and which remains unread (Bernard, et al., 2008).

As we see, the creation of a true accessible material is not a mere digitization of print. It does not suffice to scan, type or input information in any other way to get a quality digital product. Unless certain rules that apply to the operation of synthetic voice are met, the final output might not entirely satisfy the needs of the reader with print issues.

### ACCESSIBLE ELECTRONIC TEXTBOOK

Having examined a number of electronically available textbook, the author, in an attempt to list components for “the ideal textbook,” created the following chart. (Figure 3)

<table>
<thead>
<tr>
<th>Visual Output</th>
<th>YES</th>
<th>NO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color and size adjustments?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text highlighting?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alt text or clear captions for images?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Images in high resolution?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Large image function?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical Access</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alternative controls (voice, switch or keyboard control)?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear section and page navigation?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hyperlinks to complementary information?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note Taking and Studying Features</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Highlighting features?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bookmarking?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy and past enabled?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search feature?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Glossary? Voiced / Unvoiced (circle one)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3: Features of accessible electronic textbook

This chart is also a checklist that the entities that create textbooks could use to find out if their products have any of the features and options. In accordance with Universal Design for Learning, learning material should be addressed to all learners, regardless of their learning styles, abilities or disabilities. Textbooks should consider sensory and physical access to information. They should also offer options that would support learners in studying and note taking. Textbooks are more than just books, they are learning tools. Together with online resources they constitute the basis for gathering and analyzing available information.

ATIA, or Assistive Technology Industry Association, crafted guidelines for designing and programming software in order to meet some basic accessibility standards. They suggest that new products have built-in AT compatibility options so that users with different concerns do not have to seek additional, third party solutions. AT companies save persons with disabilities from creating a myriad of adaptive tools to patch deficiencies of mainstream products; however, the compatibility is not always seamless and fully functional.

All of the above solutions and initiatives appear to be merely a patchwork covering expansive holes in the provision of alternate material. Competitiveness in the textbook markets and the increasing number of institutions that convert hard copies into more flexible formats might encourage or even compel publishers to pre-design their new creations in the manner that is compliant with the UDL guidelines. If school districts begin to opt in for the publishers that can satisfy all their textbook requirements, there is a possibility that a greater variety and improved accessibilities will be incorporated into online and offline electronic publications.

Students, as human beings, bring yet another dimension to the whole issue of “readable” textbooks. Adolescents, in particular, are extremely sensitive to their appearance and their image. They are aware of their differences but they often try to cover them, pretending they are just like any other teenager. They dodge anything that would stigmatize them or even traumatize them. Disability, in itself, still seems to be a reason for discrimination among the peers. It is probably the worst kind of discrimination for young people with disabilities. The author assumes that his experiences are not unique to his work placement and that similar behavioral paradigms are known to other educators who work with students with disabilities. A third party software or hardware may not be sufficient to make an accessible textbook. The textbook itself should be accessible and it should not look conspicuous. Accessible books should not separate but connect people. New generations expect to be prepared to meet the needs and challenges of the modern world. Information and digital technology, being omnipresent, have to be mastered by the school-age people so that they can continue to improve their life and the life of the following generations. Digitally rendered textbooks can help them realize the potential of technological breakthroughs.
All students, whether with or without cognitive, sensory or physical concerns, may find it more natural to use the electronic format rather than a paperback edition. They spend significant amount of time interacting with and through the computer. Besides, educational institutions should be held accountable for instructing young people in how to benefit from modern technology in a safe and responsible way.

Online publications lend themselves to being a solder in a classroom full of teenagers. The format, interface and medium would all be the same for every student. Naturally, some individuals who require certain support would need to select appropriate options, but overall, those options would be available for anyone. Those students that perceive assistive technology as discriminating would work with identical learning material as their peers. They would not be ashamed of alternate format that sets them apart from the rest of the class.

Those are issues and challenges that need to be surmounted in order to truly include all students in the educational system.

We are still in the situation where accessibility is added as a retroactive process. Instead of combining all the knowledge, experience and requirements to create books for all, publishers focus primarily on designing and producing paper-based books. It appears that relatively little attention is put to pre-conceptualize modern learning tools to integrate learners with and without special needs.

CONCLUSIONS

Today’s technology is so powerful that the creation of alternate formats, electronic and digital text in particular, is relatively easy and inexpensive. With the support of such entities as Bookshare, RFBD, or NIMAS, students with print disabilities should not be deprived of alternate and accessible formats. Numerous recent discussions, dating back to the 1990s conclude that digital text with speech capabilities improves students’ performance. Digital formats have been known for at least 20 years and yet, we’re still debating about whether or not such formats can improve students’ educational outcomes. It is also unfortunate that there is still a group of special educators, as well as regular education teachers, whose familiarity with the latest technological breakthroughs is rather mediocre. Some research and experience also indicate that instead of arming students with powerful and improved assistive devices and software, teachers prefer reading by themselves or assign their paraprofessionals to be the readers.

There have been numerous attempts over the years to ensure the provision of accessible books. State, local governmental agencies and organizations with private corporations and publishers have congregated and debated over technicalities and standards of alternate formats. A majority are in accord that XML appears to be the most appropriate language to encode electronic information that can subsequently be converted into a user-friendly product. Yet, despite all those efforts, many students with print disabilities are handed standard textbooks and are expected to score high on standardized tests.

Years go by and so do generations of students without full access to their learning material. They pass from one grade to another; they eventually graduate, regardless of whether they have mastered all the required knowledge or not. Since they are protected by IDEA, it is not advisable to retain them in the same class for the next year. As long as they meet IEP goals, they are promoted. How much more would they learn if reading, or in this case, reading combined with listening, was readily available. It cannot be assumed that a mere provision of suitable formats will conjure magic results overnight. Students will need time, patience and structured training before becoming proficient users of auditory literacy media.

All of the above are the measures that NIMAS was supposed to eliminate. It was to streamline the process of creation and delivery of accessible textbooks without compromising quality or violating copyrights. The rumor has it, however, that publishers are considering expanding their offer of alternate formats to avoid middlemen and keep the benefits to themselves.

It can be safely predicted that Digital Text Books (DTBs) or other similar forms of presentation will become even more ubiquitous. Schools will need to revisit their book adoption process in order to be more effective and economical in the purchasing and delivery of new textbooks. Without cooperative actions, common understanding, knowledge of research-based results and, eventually, a will to truly differentiate instruction, significantly larger numbers of students with print disabilities will not reach their potential. It is not enough to convert paper into zeros and ones to achieve the goal. Technology to turn paper into digits has been present for at least two decades. It is constantly improved to satisfy end users. The barrier is not in lack of technological options but in the mindset of people involved in the process. Even people who seemingly are knowledgeable about accessibility issues may occasionally practice against their own preaching. AFB Accessible Textbooks and Instructional Material for Students with Visual Impairments June 2003 revision is a comprehensive electronic publication about the production of alternate formats for people with visual impairments. Any reader would expect a full and unobstructed access to either read visually or by employing synthetic voice. They will be, however, immediately disillusioned because the publication has been secured, disabling text-to-speech operations.

REFERENCES


ABOUT THE AUTHOR

Jaroslaw Wiazowski, PhD, is the Staff Development and Assistive Technology Coordinator for the Siloe Educational Center, Polokwane 0700, South Africa.

He can be reached by e-mail at jarwiaz@gmail.com
**INTRODUCTION**

Worksheets are used to increase guided practice or independent practice of skills that have already been taught. Children with learning difficulties often require additional practice to achieve mastery and often worksheets are used to serve this purpose. In Malaysia, because of the lack of resources for special needs, special education teachers often make copies of worksheets taken from kindergarten or primary school books to be used for children with cognitive disabilities. These worksheets, however, are not suitable for children who need to learn tasks in small incremental steps. Often, these copies do not support systematic instruction. A solution was sought to help teachers develop worksheets that can be customized to suit their students’ ability level. This led to the development of Flash-based Worksheet Creators, which are now stored in a Malay language open educational resource repository for special education (ePKhas repository).

**WORKSHEETS FOR INDIVIDUAL NEEDS**

These Worksheet Creators aim to help teachers match worksheet tasks to student ability levels. This is achieved through having diversity of tasks for a particular learning outcome and through manipulation of built-in variables in the Worksheet Creators. Through manipulation of these built-in variables, worksheets can be individualized, customized and differentiated. Tasks can be broken down into small chunks and sequenced according to individual needs. The amount of scaffolds (prompts and fades) and types of responses required can be differentiated. In addition, the use of stimulus can be customized.

**ACCESS TO THE WORKSHEET CREATORS**

   You will see the main page of the repository.

---

**Figure 1:** The ePkhass Web site for special educators.
2. Click on the word “English” in the upper left corner of the page to translate the page to English (Google Translation is used). Refer to Figure 1.

3. After translation, click “Join Now” in the blue text box located at the left side of the page (Figure 1).

4. A form page will appear for you to register as a member. Fill in the particulars required.

5. Once the registration form is filled, click “Accept Terms & Condition of Use” and then click on the “Open a new account button”. You are now in the repository. (Registration and access is instant.)

6. This is where the English translation ends. Your profile in Malay will be shown.

7. To access the Worksheet Creators page, click on the “Sumber Pengajaran” (Teaching Resources) menu to open the drop-down sub-menu. In the drop-down sub-menu, choose “Penjana Lembaran Kerja” (Worksheet Creators). (Figure 2).

8. The bilingual Worksheet Creators page will appear. Currently, there are eight types of worksheet creators in the repository; each of these are for a specific learning objective. To access the English version of each worksheet creator, click on the “EN” button that appears in the upper right corner of each of the worksheet creators or choose “English” for language.

Below are descriptions of six types of worksheet creators.

**HANDWRITING WORKSHEET CREATOR**

**Learning objective:** Practice handwriting skills

Handwriting skills can be individualized by using the student’s own name, address, telephone numbers or other personal information for practice. Worksheets can be created for different ability levels using faded prompts, such as from big to small prints, from tracing to joining of dotted lines, and to a single first letter as prompt. Once a worksheet is created, click on ‘Print’ to get a printed copy of the worksheet.

**NUMBER/ALPHABET SEQUENCE WORKSHEETS CREATOR**

**Learning objective:** Practice number or letter sequences

Practicing of number and letter sequences can be individualized as worksheets can be created to start from any letter or any number from 1 to 95. The different choices in the “Show” variable (Alternate/Random/Empty) allow teachers to customize their worksheets.

**CLOCK SKILLS WORKSHEET CREATOR**

**Learning Objective:** Telling Time

This worksheet creator helps teachers to create worksheets for four types of clock skills as shown in Figures 3 and 4. Different types of tasks can be suited for different ability levels. For example, it is easier for students to match clock time to digital time than to draw clock hands or to read clock time. Time setting for the tasks is virtually unlimited, which means that teachers can create worksheets in incremental steps based on student ability. The worksheets can be created to practice telling time systematically.

**CALENDAR SKILLS WORKSHEET CREATOR**

**Learning Objective:** Comprehending calendar

Comprehension of calendar skills is difficult for students as it involves the concept of future. Students need constant practice to understand the concept of days, weeks, months and years. Worksheets can be created in sets so that
students can practice how to sequentially chain the days so that it builds up to a week (e.g. Figures 5 and 6), chain the weeks so that it builds up to a month, and chain the months so that it builds up to a year.

**FACIAL EXPRESSION WORKSHEET CREATOR**

**Learning objective:** Recognize facial expressions

There are eight types of facial expressions to choose from. Worksheets showing up to four different types of facial expressions can be created. In the example below (Figures 7 and 8), the facial expressions on the left are labeled, whereas those on the right are to be answered by students.

**ADDITION/ SUBTRACTION WORKSHEET CREATOR**

**Learning objective:** Addition or Subtraction procedures

This worksheet creator allows teachers to set the number and the semi-concrete objects in addition and subtraction questions. The number sets and the semi-concrete objects that represent the number sets can be manipulated so that the intensity of prompts, the type of response, and the difficulty level of items can be differentiated for individual students. Students can demonstrate understanding, either through numbers or through drawing of semi-concrete objects. The first worksheet illustrates different questions with varying prompts, difficulty level and response type. The second worksheet requires only a singular type of response with the provision of maximum prompts.

**OPEN EDUCATIONAL RESOURCE**

Registration and access to the resources in the ePKhas repository is free as they are distributed under the Creative Commons license, which allows unlimited use of the materials for non-commercial purposes. Returning members just need to login using their username and password.

**WEB SITE**

ePKhas: A repository of multimedia resource for special education: http://epkhas.ses.usm.my

**AUTHOR INFORMATION**

Assoc. Prof. Dr. Lee Lay Wah is the Program Chairperson (Special Education) at the School of Educational Studies, Universiti Sains Malaysia. She has developed ePKhas, the first and sole repository of multimedia resources for special education in Malaysia. She can be contacted at lwah@usm.my or mydyslexia@gmail.com.

Her mailing address is:
School of Educational Studies
Universiti Sains Malaysia
11800 USM
Penang Malaysia

![Figure 5: Calendar worksheets creator](image1.png)

![Figure 6: Sample calendar worksheets](image2.png)

![Figure 7: Facial expression worksheet creator](image3.png)

![Figure 8: Sample facial expressions worksheets](image4.png)
ABSTRACT
The primary aim of this article provides readers with a discussion about specific tools and features of two versions of the word processing program, Microsoft Word 2003 and Microsoft Word 2007, that may be of benefit in helping students with dyslexia in their studies. As newer versions of Microsoft Word are released, so are more comprehensive features being offered to many users including students with dyslexia. In the course of this article, a selection of the most important facilities will be outlined followed by describing how each feature operates, in addition to pointing out its potential benefit for student use. The final part of the article presents the reader with a detailed discussion on the prospective benefits of using word processing software for students with dyslexia.

INTRODUCTION
The benefits of information communication technology have transformed the academic experience of students with learning problems (Morrison, 2007: 83), in particular those with dyslexia. It is, therefore, not surprising that the educational field is constantly being affected by this medium and has become an important teaching and learning tool for both students with and without dyslexia (Wahl, 1996: 1). The British Dyslexia Association (B.D.A., 2010: 1) declare the potential of using a word processor has resulted in making major differences for students with dyslexia by assisting and supporting them with the writing process (e.g. organizing and structuring ideas for those who have problems with presentation or handwriting, preparation of presentations, and help for those with handwriting problems (B.D.A., 2010: 1). The word processor is a highly important written communication tool and enables easy drafting and editing (B.D.A., 2010: 1) and as Keates (2002: 9) declares, it represents an environment in which this category of students can excel. With the evolution of the word processor and especially with the development of Microsoft Word and its abundant features, these applications provide a better mechanism for supporting the students with dyslexia.

WHAT IS MICROSOFT WORD?
The Microsoft Corporation (Microsoft Corporation (a), 2008) describes the word processing application, Microsoft Word, as being a:
“powerful authoring program that gives users the ability to create and share documents by using a comprehensive set of writing tools within an easy to use MS Office user interface”

This program allows individuals to create content and documents more quickly and simply in a professional manner. The application contains a collection of tools and facilities to construct documents from a variety of predefined parts and styles, in addition to allowing students to compose information within it (Microsoft Corporation (a) 2008). Lerner (2000: 56) states that “word processing is a boon for students with learning disabilities who have difficulty in handwriting, spelling and written composition,” whereby studies show the greatest difficulties have been found with aspects of grammar, punctuation, spelling, organization and coherency (Raskind, 1993: 187). Consequently, using a word processor, like Microsoft Word, may prove to be a key in addressing many of the problems experienced by these students with dyslexia.

SPECIALISED WORD PROCESSING COMPONENTS
Word processors, such as Microsoft Word, contain a collection of features that can greatly assist in the reading, writing and spelling of a document, like thesauruses, spell-checks, grammar checks, and editing facilities. MacArthur (1996, Lewis et al (in press) cited in Lerner, 2000: 454) states these tools support the reading and writing process by making it easier for the student to write, correct and revise their own writing. Lewis (1998, cited in Evans, 1999: 8) emphasises the fact that all word processing programs should provide the following range of functions to make...
using Microsoft Word easier for students with learning disabilities, including those with dyslexia, when this program is being used:

- Word processing using voice input devices with speech feedback for the task of editing;
- Software to aid in planning and organizing ideas when preparing for writing;
- Thesaurus and dictionary;
- Software for editing spelling;
- Spellcheckers into which subject specific academic vocabulary can be entered; and
- Software for editing grammar with speech feedback to assist in detecting meaning inconsistencies.

The concept of using a word processor in an efficient and resourceful way could prove to be an impossible milestone for a student with dyslexia, but at the same time, if they can succeed in using information communication technology, this “...can lead to students becoming more confident, independent users” (Fintushel, 2001: 4).

Figure 1 presents a range of facilities in Microsoft Word that may be useful to students with dyslexia:

### SPELL-CHECKERS

The use of a spell checker can act as a possible support for a student with dyslexia at college. All word processing programs come with a built-in spell checker with an interactive error alert, such as highlighting. By default, Microsoft Word automatically scans the spelling of words as they are typed and uses wavy red underlines to indicate possible spelling problems (Microsoft Corporation (b), 2010). If the user performs a series of clicks on the word, the program offers a short list of alternatives (Dyslexia Teacher, 2005).

Montgomery (1997: 134) claims these types of tools avoid the awkward task of locating the incorrect word and editing it by physically typing the correct letters. There is greater potential with these devices in terms of composing and developing ideas. Before using a spell checker, it is recommended by the author that the student should provide a printout of the document and proof read the text before using the spell checker. This can help identify areas of difficulty that both the pupil with dyslexia and tutor can address. The purpose of this allows the students to take on some initiative and responsibility for their own learning (Montgomery, 1997: 134). The Spell Check tool in Microsoft Word 2003 is located by clicking on Tools ➔ Spelling and Grammar or by pressing the F7 key (see Figure 2) spelling errors appear in red. Should one wish to turn the Automatic Spelling Check on/off, click Tools ➔ Options ➔ click on Spelling and Grammar tab; select/clear the ‘Check spelling as you type’ check box (Microsoft Corporation (c), 2010). In Microsoft Word 2007, the Spell Check tool is found by clicking on the Review Tab of the Microsoft Word ribbon followed by clicking on Spelling and Grammar.

### GRAMMAR CHECKS

The Grammar Check tool in Microsoft Word is a type of “natural language” grammar checker that scans and warns of conditional problems by performing a comprehensive analysis of text (Microsoft Corporation (d), 2010). The Grammar Check tool may not search for all types of problems, but tries to aim toward grammar errors that are highly typical or most frequent. Fintushel (2001, 4) stresses the point that “grammar checks are not refined enough to accurately differentiate between precise grammar rules, verb subject agreement and writing styles for students whose grammar deviates significantly from the norm.”

The Microsoft Word application scans grammar as it is automatically typed and uses green wavy underlines to indicate possible grammatical errors (Microsoft Corporation (b), 2010). Many of the errors can go undetected and those that are identified can turn out to be correct. When learning disabled students are being taught to write, these individuals want to write without worrying about making mistakes, but as Fintushel (2001: 4) points out “a grammar check may counteract this objective.” By using Microsoft Word, the program has the facility of highlighting grammatical mistakes and offers many options for the student to select from (Fintushel, 2001: 4). The Grammar Check is located in Microsoft Word 2003 within the Spelling and Grammar tool by clicking on Tools ➔ Spelling and Grammar or by pressing the F7 key and the text appears in green. Should one wish to turn the automatic grammar check on/off, click Tools ➔ Options ➔ click on Spelling and Grammar tab ➔ select/clear the ‘Check Grammar as you type’ check box (Microsoft Corporation (c), 2010). In Microsoft Word 2007, the Grammar tool is located by clicking on the Review Tab and then clicking on Spelling and Grammar. See figure 3.

---

Figure 2: Spelling and Grammar facility in Microsoft Word 2003

Figure 3: Accessing the Spelling and Grammar tool in Microsoft Word 2007
THESAURUS

In order for writing to be interesting, the student with dyslexia has to be able to express similar ideas in a variety of ways. Consequently, the use of a thesaurus could be a key in addressing some of these issues. A thesaurus can display multiple words and synonyms for the student’s word selection. In Microsoft Word 2003, when a student with dyslexia identifies the word they wish to express in an alternative format, the user can press the thesaurus key, i.e. Shift Key + F7 or right click on the word and select Thesaurus. This thesaurus facility can provide a means for students to increase their vocabulary and, if used consistently, reinforces that new vocabulary (Fintushel, 2001: 5). This tool is a clever and useful feature for a visual spatial learner (Silverman, 2002: 4) and “by using this tool, students with dyslexia become confident independent writers” (Fintushel, 2001: 4). In Microsoft Word 2007, the Thesaurus tool is located within the Review Tab followed by clicking on the Thesaurus button.

MACROS

A macro can be defined as “a sequence of commands for performing a task” (Cantor, 2003: 1). These tasks may be simple, for example, inserting a word, or a complex task, such as copying data from one program and pasting it to another. Macros are used to record a sequence of actions (Microsoft Corporation (e), 2010) or for tasks that are repetitive, physically demanding or mentally tasking. They can be written to insert a person’s name, address or e-mail address; insert symbols and foreign characters; insert the date and time; abbreviate words or expressions; or even open a file (Cantor, 2003: 1). Cantor (2003: 2) explains four main macro creation techniques that may be helpful to students with dyslexia when it comes to using word processing packages:

• Capture: This allows the user to record commands by typing and manipulating the mouse
• Wizards: These features guide the user through a series of questions and automatically generate a script
• Direct editing: This facility allows the user to type or insert commands into the macro editor
• Semi-automatic techniques: This tool allows the user to select, insert and edit command via a user interface to build a script (Cantor, 2003: 2)

Macro techniques help students with learning disabilities like dyslexia to perform tasks quickly and efficiently by saving time, energy and frustration. (Cantor, 2003: 6). The Macro tool can be accessed in Microsoft Word 2003 by clicking on Tools ➔ Macro ➔ Record New Macro ➔ Give the macro a name or by pressing ALT + F8. In the Store Macro In, click the template/document where the macro is to be stored. In the Description box, type a description for the macro. Finally, if the user does not wish to assign the macro to a toolbar/menu/shortcut keys, click OK to begin recording the macro. In Microsoft Word 2007, the macro tool can be accessed by clicking on the View Tab, followed by clicking on the Macro button.

AUTOCORRECT

The AutoCorrect facility is a feature available in Microsoft Word used to identify and correct spelling and other errors as they are being typed (AbilityNet, 2002). An individual can add misspellings to an “AutoCorrect” table that will automatically change to the correct spelling as the user hits the spacebar or full stop after a word. Many students with dyslexia achieve significant improvement by being allowed to add their most frequent problem words to the table. The AutoCorrect facility also has the ability to expand abbreviations into phrases or paragraphs (AbilityNet, 2002). For example, the AutoCorrect facility could be used in a sequence like: Type “y”, “s” and hit the spacebar to produce “Yours sincerely.” In certain versions of word processing applications, auto text entries are automatically offered as the user types on the screen. Macros work on a similar concept as the AutoCorrect facility, but these tools handle commands, as well as text and graphics (AbilityNet, 2002). An application like Microsoft Word has the added advantage of being able to autocorrect common or personal spelling errors as they are being typed (B.D.A., 2007). This tool works automatically in both versions of Microsoft Word 2003 and Word 2007.

Another similar tool to using the AutoCorrect facility is to operate the AutoComplete facility which is located within the AutoCorrect Options tool. To access this tool in Microsoft Word 2003, click Tools ➔ AutoCorrect Options; Select the AutoText tab ➔ click/unclick Show AutoComplete suggestions ➔ click OK (see Figure 4).

OUTLINE VIEW

When students with dyslexia are planning to write about a topic in Microsoft Word, the individual may find it helpful to use the Outline facility (AbilityNet, 2002). The Outline View is a tool that displays document headings that are indented to represent their level in the document’s structure. Users who operate this tool can also use the outline view tool to work with master documents (Microsoft Corporation (f), 2010). Certain applications contain a facility to develop an outline before a dyslexic student writes in detail. This tool means the student can “talk through” what is to be written or make brief notes that will be further expanded at a later stage (AbilityNet, 2002). As a result, Microsoft Word simplifies the formatting of text so that users can focus on the structure of the document (Microsoft Corporation (f), 2010). Users can make a variety of formatting changes in outline view: each heading level is formatted with the appropriate built-in heading style (Microsoft Word 2003 has nine different built-in styles); the indentation of each heading according to its level that only appear in Outline View; paragraph formatting that controls the appearance of a paragraph (indentation, alignment, line spacing and pagination); and displaying the outline as plain text (Microsoft Corporation (f), 2010). To access the Outline View tool in Microsoft Word 2003, click View ➔ Outline View.

LETTERS, FONT SIZE AND FONT SPACING

Larger letters and words can prove to be quite helpful and beneficial for those with a learning disability, like dyslexia and for those whose vision is not a problem. Letter size can be adjusted in the Font Size facility, the Font Style facility and the Zoom text facility.

The Font Size: The Font Size can be set to single, 1.5 or even double spacing; with the added facility of left, right, centre or default justification of text for the purpose.
of reading, writing and editing. The text on the screen can be readjusted to single spacing for the purpose of printing and editing (AbilityNet, 2002).

Font Styles: The user also has an endless selection of font styles and types to choose. Certain font styles and types are easier to read than others, e.g. a non serifed style “Arial Text” versus a serifed style “Times New Roman.” Even a tool like a “non proportional” font, such as “Courier Style,” can make the printed style look bigger and easier to read rather than a proportional font (AbilityNet, 2002). To access the Font tools in Microsoft Word 2003, simply click Format ➔ Font or press CTRL + D.

To access the Font facility in Microsoft Word 2007, click the Home tab and choose the appropriate letter size/type/style and alignment.

COLOR SCREENS

AbilityNet (2002) claims that many students with dyslexia who have a color computer screen can really benefit from using a word processing package by being able to choose and adjust the colors that suit them best. The user has an endless selection of font and background colors to choose from that can greatly enhance the quality of life for a person with dyslexia (AbilityNet, 2002).

SEARCH AND REPLACE FACILITY

The Search and Replace facility is a simple but highly effective tool in Microsoft Word. Its role is to identify and locate repeated errors for correction. The user only needs to type the error and corrected version once and the other corrections will be performed automatically and can be located from the Edit ➔ Find and Replace menu (B.D.A., 2007). In addition, the Search and Replace facility is also used to find and replace text, formatting, paragraph marks, page breaks and other items (Microsoft Corporation (g), 2010). To access the Find tool only, click Edit ➔ Find or by pressing (CTRL + F). To access the Find and Replace tool, click Edit ➔ Replace (press CTRL + H). Type the word that the user wishes to search for in the “Find What” field and in the “Replace With,” type the word that you wish to replace it with, followed by clicking Replace/Replace All.

To access the Find or Replace facility in Microsoft Word 2007, click the Home Tab, followed by clicking on the Find or Replace facility.

MICROSOFT WORD VOICE RECOGNITION PLUG-IN

The speech recognition facility is only available in Microsoft Word 2000 or Microsoft 2003 and is offered in Simplified Chinese, Traditional Chinese, English (US/Ireland) and Japanese language versions of Microsoft Office (Microsoft Corporation (h), 2008: 1). Users can use this facility to dictate text into an Office 2003 program by using a selection of menu, toolbar, dialog box and task pane instructions. Even though speech recognition is not specifically tailored for completely hands-free operation, users will achieve significant results if they use a combination of voice with mouse and/or keyboard interactions (Microsoft Corporation (h), 2008: 1). The Microsoft Word speech recognition facility is located by clicking the “Tools” facility ➔ Speech at the top of the main menu.

Once this has been activated, the speech recognition toolbar is positioned or “floats” above Microsoft Word and appears as a “language bar” facility with hidden text labels (Microsoft Corporation (h), 2008: 2). First time users must participate in a speech training task so that the computer can recognize how the individual speaks, in addition to increasing speech recognition accuracy (Microsoft Corporation (i), 2008: 2). Once this has been completed, the users are offered a variety of tools to use when dictating.

THE ROLE OF A WORD PROCESSOR

Raskind (1993: 187) remarks that researchers have claimed word processing software to be a valuable tool for assisting students with learning disabilities, especially when compensating for written language problems. Sun Associates (2001: 5) state that word processors are used by teachers to create many types of documents, such as lesson plans, student/parent communication and personal correspondence. Students with dyslexia often use a word processor in similar ways to write up research papers, carry out projects, doing assignments and other written documentation, all of which can be accomplished by using this program (Sun Associates (2001: 5).

BENEFITS OF USING A WORD PROCESSOR

Although many facilities are freely available in Microsoft Word for dyslexic students to use with reading and writing, it is important to remember that these applications contribute a variety of personal, academic and physical achievements for them.

MOTIVATION

Word processing applications allow a learning disabled student to produce clear, legible typed information on the screen that offers encouragement and motivation for the individual to write extra information. These programs provide the dyslexic student with an endless collection of formats in which to publish their material (MacArthur, 1996; Lewis et al in press) cited in Lerner, 2000: 454).

Word processors allow students with dyslexia to concentrate on the meaning of their typed information rather than being preoccupied with the mechanical aspects of writing (Raskind, 1993: 187). This is a highly important feature for them since they can often develop a fear of translating their thoughts into written language due to their writing problems. Raskind (1993: 187) explains that the satisfaction of these students knowing that they can produce language at ease and correct errors at a later stage is often found to unshackle their writing abilities. For example, omitted text can be added; unsuitable words or blocks of text can be deleted; sentences and paragraphs can be moved with ease; and text can be easily bolded, centred or underlined (Raskind, 1993: 187).

COLLABORATION

Word processing applications teach students to collaborate in the writing process with their tutors and colleagues because of screen visibility and anonymity of printed text (MacArthur, 1996, Lewis et al (in press) cited in Lerner, 2000: 454). Lerner (2000: 452) stresses the importance of using this application by stating that it acts as an excellent medium for teaching, writing and integrating with language systems. Word processors produce a one-to-one interactive environment where students can practice recently acquired reading skills on a constant basis (Lerner, 2000: 56).

EASE OF REVISION

The editing tool can be regarded as being an important facility for any student with dyslexia to use in any word processing program. It can ease the physical burden of revising, making it more manageable to correct, revise and rewrite material. Secondly, the learning disabled student can insert, delete, edit and change the content on the screen until the correct information has been displayed, all by the click of a button. Thirdly, after the necessary changes have been made, an individual can print off the draft, make additional changes on the page and then make the necessary corrections on the computer screen (MacArthur, 2002).
of applications tailor the program's design in a way that is equal to their intelligence level. Since a word processor detects errors on the computer screen before the document is printed, the student will end up with a neat and organized document that helps them develop a sense of pride in their written work, as well as enhancing their image as writers. Consequently, this can result in a more positive approach to writing (Raskind, 1993: 187).

HELP WITH FINE MOTOR PROBLEMS

Since the role of writing can be a difficult and arduous task, the process of typing is inherently easier, neater and more rewarding for a student with fine motor problems (MacArthur, 1996, Lewis et al (in press) cited in Lerner, 2000: 454). The word processor can eliminate the need for retyping and makes the learning disabled student apply more time and energy to the most important aspect of the writing process, i.e. thinking about the content, editing and revising (MacArthur, 1996, Lewis et al (in press) cited in Lerner, 2000: 454). Word processors help in the writing process for these students by providing a technique to allow them to write down their thoughts and ideas without worrying about making mistakes (Fintushel, 2001: 3). For a person with a learning disability, writing becomes a less arduous task (Lerner, 2000: 452). By using a word processor, the individual with dyslexia can write without worrying about handwriting, spelling and grammar problems.

CONCLUSION

The main aim of this article was to explore and describe a selection of important word processing components in both Microsoft 2003 and Microsoft 2007 that are readily available for students with dyslexia to use for the purpose of reading, writing and spelling. A description was provided about each facility that also explained the importance of using these features, followed by explaining how to access each individual facility. The final part of the article concentrated on describing the benefits of using word processor applications, in general, for both personal and academic use for students with dyslexia. Since these students can have many difficulties with reading, writing and spelling, it is imperative that developers of these types of applications tailor the program's design in providing additional tools to support these student needs wherever possible. Meanwhile, academics, teachers and educational professionals should constantly explore how other features of word processing programs that were not described in this article can be specifically tailored to the individual needs of the student with dyslexia. Further research could concentrate on examining this theme in more depth.

BIBLIOGRAPHY

BOOKS


CONFERENCE PAPERS


JOURNALS


E – JOURNALS


WEB SITES


**AUTHOR CONTACT**

John Phayer can be contacted by e-mail: johnphayer@yahoo.co.uk
Texthelp Systems, award-winning software publisher, has announced the newest release of its literacy support software solution, Read&Write 4 GOLD for Mac. Read&Write 4 GOLD for Mac directly integrates with familiar Apple Macintosh applications, including Microsoft Word for Mac 2008, Safari and Adobe Reader, giving students access to the reading, writing and research support tools they need while working within the programs they use everyday.

The exciting new features and enhancements in Version 4 provide even more support for the variety of learning styles and abilities found in today’s schools, colleges and universities. New features include Screenshot Reader, Screen Masking, a MOBILE USB version and Feature Video Tours. In addition, concurrent and unlimited site licensing for school and home use are now available.

“Since we first introduced Screenshot Reader, one of Read&Write GOLD’s most powerful features, customers have been requesting that we add it to the Mac product. With Version 4, Mac users now have access to even more digital content, including inaccessible text. In addition, the MOBILE USB version, along with concurrent and unlimited site licensing for school and home, make Read&Write 4 GOLD for Mac the most flexible literacy support software solution available today. With Read&Write GOLD, all students can be successful in and out of the classroom,” said Jack Dolan, President, Texthelp Systems Inc.

NEW FEATURES INCLUDE:

• Screenshot Reader – Access text that was previously unreadable - including text embedded within an image or contained within inaccessible Flash - and have the text read aloud with dual color highlighting. Users can also export text selected with Screenshot Reader directly to Microsoft Word.

• Screen Masking – Tint the screen like an overlay, using any number of colors to mask the screen. This feature is helpful to individuals who have trouble focusing on the screen. Masking types include full screen tinting, mouse underlining and mouse spotlight options.

• MOBILE Version – Read&Write 4 GOLD MOBILE for Mac is available on a USB Flash drive. This exciting MOBILE software product provides users with all of the features of Read&Write GOLD for Mac, with the added benefit of being able to use it anytime, anywhere.

• Concurrent Licensing – Concurrent Licenses can be shared among users in a school or among schools within a district; licenses can be used at school or at home.

• Unlimited Home Site License – Unlimited Home Site Licenses allow schools to give an unlimited number of students access to Read&Write GOLD from home.

• Product Feature Video Tours – Video walkthroughs of all features are available from the toolbar or at www.texthelp.com.

PRICING AND AVAILABILITY

Read&Write 4 GOLD for Mac is available now. Pricing options include unlimited site licensing for school and home, concurrent licensing for school and home, and single user licenses (DVD or USB) with volume discounts available. Pricing starts at $645 (US) for a single copy. Single user pricing of $295 (US) is available for students at schools with site licenses. For sales and ordering information, call 888-248-0652 or e-mail u.s.info@texthelp.com, or visit www.texthelp.com.
**New Screen Magnifier and Reader Offers True Portability**

WinZoom USB is truly portable and will run on any Windows compatible computer with no software installation required. Simply plug WinZoom USB in and the autoplay function will launch the application immediately and let you use it without having to download any software or drivers. There are no administrative privileges required, which is key when using a public computer, such as ones at a hotel, library, school or even at a friend’s house. When you are done, just unplug WinZoom and there is no trace left on the computer. WINZOOM - $299; WINZOOM USB - $399.

- No installation
- Automatically starts
- Instant magnification
- Works on any Windows computer -- including public locations (hotels, libraries, family, work)
- Leaves no files behind
- No administration privileges required
- Affordable

**OTHER FEATURES**

- XP, Vista and Windows 7 compatible (including 64 bit)
- 100 percent portable (USB Version) with Magnifier and Reader for one low price
  - Provides magnification between 1.5x-36x
  - Font smoothing for clear text with Zoom scroll bars
  - Reduces glare

---

**The Lord is My Shepherd Mac/Win CD**

Branch of the Vine Software and Marblesoft have announced the release of their new software program, “The Lord is My Shepherd” Mac/Win CD. Designed for the home user who uses assistive technology or the Sunday school classroom reaching out to individuals with special learning needs, The Lord is My Shepherd is intended to reach all users with the message of God’s love for them. No prerequisite skills are required.

The Lord is My Shepherd CD presents Psalm 23, Good News Translation, in 12 screens, with each line of the Psalm illustrated and animated. As the narrator reads aloud each screen, the corresponding text is highlighted, engaging early readers. Music and song help make this program appealing. Early readers and switch users page through the story at their own pace, stopping to repeat the narration, play with the animation or just enjoy the rich scenery and soothing sounds.

The principles of Universal Design have been incorporated into The Lord is My Shepherd. Dozens of options allow the program to be customized for any user, from auto-play to cause and effect to full interaction. It can be controlled with mouse, keyboard, touch screen or switches, including single switch auto-scan and two switch step scanning. True auditory scanning with verbal prompts for low-vision users is another option. Each word is optionally highlighted as it is spoken. There are lots of choices for parent or teacher control. Illustrations by Michael Walker are appropriate for all ages. A story book of all slides is included in PDF format for printing. Original background music and song by Bill Downey is also included.

The Lord is My Shepherd CD is an ideal supplement to Christian education, making the Gospel clear and accessible to all individuals. It is the first of a series of software programs designed to teach basic truths from the Bible in a simple and visually appealing manner to individuals with cognitive impairments, including those with developmental disabilities and autism spectrum disorders.

For more information, please contact Branch of the Vine Software, 706 Kopmeier Drive, Pewaukee, WI 53072, 262-391-3476, e-mail: info@branchofthevinesoftware.org, www.branchofthevinesoftware.org.

Autism Tomorrow covers topics of concern for families of children faced with the communication, social and emotional challenges associated with autism. Practical advice on everything from nutrition and exercise to bullying and puberty is provided by 16 leading experts, including Dr. Temple Grandin, Stephen Shore and Karen Simmons. The guide also answers common questions that arise as a child with autism nears adulthood, such as employment, financial security and independent living.

“Autism Tomorrow is truly a practical guide with easy-to-use strategies to help children across the autism spectrum survive and thrive in the real world,” says Cindy Halloran, OTR/L and Director of The Center for AAC & Autism (www.aacandautism.com). “We are proud to have sponsored this exceptional and much-needed resource.”

The Center for AAC & Autism is dedicated to helping children with autism learn to communicate using alternative and augmentative communication (AAC) devices. The Center’s Senior Clinician, John Halloran, M.S. CCC-SLP, contributed a chapter to the guide, in which he shares one child’s journey and successes with AAC.

The Center sponsored the guide in partnership with Autism Today (www.autismtoday.com), the largest online autism resource and one of the leading autism and Asperger’s resource distributors in the world. In addition to autism-related publications, the site offers educational toys, CDs, interactive software products, reference texts, and “quick tip guides.” Autism Today also sponsors workshops and conferences where world-class experts provide skill-building opportunities for educators, professionals and parents of children with autism.

To request a free copy of Autism Tomorrow, go to www.autismtomorrow.com or call 866-9AUTISM.

ABOUT THE CENTER FOR AAC & AUTISM

The Center for AAC & Autism was developed in 2009 with support from AAC technology leader PRC (www.prentrom.com) in response to the growing demand for communication solutions for the autism spectrum disorder population.

Staffed by speech-language pathologists (SLPs) and assistive technology experts, The Center offers Language Acquisition through Motor Planning (LAMP) training seminars nationwide to teach professionals and family members AAC strategies for promoting language development in those with autism. The Center also serves as an online destination for AAC information, tools, and additional resources; supports clinical research aimed at the effective implementation of AAC within the autism arena; and facilitates sharing of best practices and success stories among clinicians and families. To learn more, go to www.aacandautism.com

ABOUT AUTISM TODAY

Autism Today was founded in 1996 by the parent of two children with autism to simplify the information-gathering and evaluating process for families dealing with Autism Spectrum Disorders. Autism Today is now the largest autism resource online and one of the leading autism and Asperger’s resource distributors in the world. In addition to autism-related publications, the site offers educational toys, CDs, interactive software products, reference texts, and “quick tip guides.” Autism Today also sponsors workshops and conferences where world-class experts provide skill-building opportunities for educators, professionals and parents of children with autism.

To learn more, visit www.autismtoday.com
Lingraphica Updates Its Speech-Generating Device with New Features

Easier to use and more flexible, Lingraphica 7 provides one-click icon search and fast message creation

Lingraphica, maker of the Lingraphica speech-generating device for aphasia, announces the release of its even more user-friendly Lingraphica 7, crafted by designers in response to feedback from both speech-language pathologists and Lingraphica users.

New One-Click Navigation mode allows users to navigate through the icon vocabulary with one simple click of a mouse, which makes finding icons and creating messages fast and intuitive.

The smart spell help enables the Lingraphica to suggest corrections for words that are misspelled, taking the worry out of spelling.

A new Icon Editor allows users, caregivers and health-care professionals to customize their own icon vocabularies by easily creating new icons and changing existing ones.

Additional grammar, math, reading and memory exercises have been added to the hundreds already included on the Lingraphica, making it easier for users to work independently to improve their language skills.

The mouth-position practice videos have been expanded to include blends, additional words with targeted phonemes, and phrases associated with dysphagia. The 700-plus videos make it easier for adults with apraxia to practice speech production.

Videos of standard oral-motor exercises illustrate cheek, tongue, palate, lip and jaw movements that help strengthen the oral musculature, providing easy, focused practice and rehabilitation.

All new Lingraphicas will be shipped with the new version. Existing customers who have owned the Lingraphica for a year or less are entitled to a free update. Those who have owned a Lingraphica for longer will need to pay a small fee. Existing customers are encouraged to contact Lingraphica to order the update.

“We know that even with all the new features, each patient has his or her own way of using the Lingraphica. That’s why we remain committed to configuring each device before it goes out the door to mesh perfectly with a particular user’s needs,” explains Lingraphica’s CEO Andrew Gomory. “We have created the device that patients and their speech-language pathologists told us they wanted. And we’re dedicated to making the Lingraphica a great experience for every single user.”

Lingraphica - The Aphasia Company is the leading provider of speech-generating devices for people whose ability to speak or understand words has been impaired by a stroke or brain injury. With the Lingraphica, they can communicate with picture icons that speak words and phrases in a natural human voice, or they can practice speech using videos and language exercises. The Lingraphica is Medicare reimbursable. It is available for a no-obligation trial. Lingraphica also offers the SmallTalk Aphasia, Dysphagia and Oral Motor Exercises apps on Apple’s App Store. For more information, call 888-APHASIA (888-274-2742) or visit www.lingraphica.com.
Closing The Gap

WEBINARS

• Presented by some of the leading, most sought-after experts in the field of assistive technology.

• Events developed around your current and pressing assistive technology needs!

• Closing The Gap will add to the breadth and scope of the Webinars and will showcase the knowledge, skills and insights of many experts in the field.

• Visit our Web site regularly to learn more about upcoming events.

Closing The Gap

COMMUNITY

• Online bulletin board designed to bring AT professionals, users and developers together

• Ask questions, get answers

• Share your tips and tricks

• Over 4,000 members

• FREE membership

www.closingthegap.com

AT resources at your fingertips
A TRADITION OF EXCELLENCE  Over the years, the annual Closing The Gap Conference has become known as the best educational assistive technology conference in North America.

Through shared best practices and research, networking, training, hands-on opportunities and an expansive exhibit hall, participants have found information, strategies and products that have proven beneficial and, oftentimes, unsurpassed for use in their work and in their lives.

The 28th Annual Conference runs Tuesday, October 19th through Saturday, October 23rd and is held in Minneapolis, Minnesota.

Preconference workshops are scheduled for Tuesday and Wednesday, October 19th and 20th, and the Conference officially begins with a preview of the exhibits on Wednesday evening, followed by three days of presentations, hands-on labs and exhibitions.

Varied levels of participation are available, with registration options listed on page 45.

Inside the next few pages, you will find detailed listings of the 24 all-day preconference workshops, over 200 presentations, exhibitors contracted to date and academic credit/CEU, air travel, hotel and registration information.

With multiple registration options available, numerous and diverse discounts, group savings and preconference workshop bundling, we invite you to participate and encourage you to bring your team!

Closing The Gap promises to work hard to insure that the content and learning opportunities are many, varied and exceptional throughout the conference week.

LEARN MORE AT www.closingthegap.com

EXCEPTIONAL LEARNING OPPORTUNITIES ALL WEEK

24 PRECONFERENCE WORKSHOPS

Closing The Gap preconference workshops are all-day, in-depth workshops presented by experts in the field in very practical and effective ways. The content and delivery are unsurpassed and the resulting outcomes for persons with disabilities are overwhelmingly positive and bright.

Many of this year’s workshops are new, some advanced, with state-of-the-art technologies being addressed and best practices demonstrated and taught.

OVER 200 PRESENTATIONS

Practical and expert-led presentations during the Closing The Gap Conference will include over 200 one- and two-hour sessions that describe and/or demonstrate successful applications of assistive technology for persons with disabilities. Select handouts will be available onsite and online following the conference.

COMMERCIAL EXHIBITS

An impressive and varied scope of AT products will be on display and will range from low tech to high tech and represent solutions for all disabilities and ages. Daily regular AND exclusive hours are scheduled to give participants quality time to explore, try, learn and ask questions, first-hand and face-to-face.

Attend all five days and earn up to THREE GRADUATE-LEVEL ACADEMIC CREDITS AND UP TO 3.4 AAC INSTITUTE CEUS!
WHO SHOULD ATTEND? ANYONE interested in finding practical and readily available AT solutions for ALL disabilities, mild to significant, infant through adult.

- Teachers
- Administrators
- Speech Language Pathologists
- Occupational Therapists
- Physical Therapists
- AT Consultants
- Technology Specialists
- Consumers
- Parents
- Students

WHY ATTEND? Participants will have numerous and unique opportunities to learn, first-hand, from experts in the field, network, ask questions, and see and try the latest AT products and strategies available today.

CONFERENCE SCHEDULE

Monday, October 18
5:00 pm - 8:00 pm ........ Registration Desk Open
8:00 am - 4:30 pm ........ Preconference Workshops

Tuesday, October 19
7:00 am - 8:00 pm ......... Registration Desk Open
8:00 am - 4:30 pm ....... Preconference Workshops

Wednesday, October 20
7:00 am - 9:00 pm ......... Registration Desk Open
8:00 am - 4:30 pm ...... Preconference Workshops
5:00 pm ............. Complimentary Hors d’oeuvres
5:30 pm - 8:00 pm .......... Preview of Exhibits

Thursday, October 21
7:00 am - 5:30 pm ........ Registration Desk Open
8:00 am - 5:30 pm ........ Presentations
10:00 am - 5:30 pm ......... Commercial Exhibits
2:00 pm - 5:30 pm ........ Presentations

Friday, October 22
7:30 am - 5:30 pm ......... Registration Desk Open
8:00 am - 4:30 pm ............. Presentations
10:00 am - 5:30 pm ........ Commercial Exhibits
4:30 pm - 5:30 pm .......... Presentations

Saturday, October 23
7:30 am - 2:00 pm ........ Registration Desk Open
8:00 am - 1:30 pm .............. Presentations
9:00 am - 2:00 pm ............. Commercial Exhibits
*The exhibit floor will close for an exhibitor break from 12:30 pm - 1:30 pm.

AAC INSTITUTE CEUS / CERTIFICATES OF ATTENDANCE

AAC Institute has been authorized to provide CEUs by IACET (International Association for Continuing Education and Training). CEUs will be offered for all conference learning sessions without charge. AAC Institute CEUs that relate to the practice of speech-language pathology and audiology can be used for ASHA certification maintenance. RESNA accepts AAC Institute CEUs for ATP/ATS credential maintenance. Most state licensure systems accept AAC Institute CEUs or other forms of self-reporting. Preconference workshops are offered for up to 1.4 CEUs. The conference is offered for up to 2.0 CEUs. For additional information visit www.aacinstitute.org/CEUs.

CERTIFICATES OF ATTENDANCE

Closing The Gap-issued Certificates of Attendance for conference participation will be available upon request at no additional fee. All preconference workshop participants will receive a Closing The Gap-issued, presenter-signed Certificate of Preconference Workshop Attendance upon completion of the workshop.

ACADEMIC CREDIT

Graduate-level academic credit from Hamline University is available for a variety of levels of conference attendance. Participants will have the option of one, two or three full semester credits.

ONE FULL SEMESTER CREDIT  Cost: $123
Requirements:
• 12 contact hours
• An outside assignment
(12 contact hours require conference participation or two preconference workshops.)

TWO FULL SEMESTER CREDITS  Cost: $246
Requirements:
• 24 contact hours
• An outside assignment
(24 contact hours require conference participation AND at least one preconference workshop.)

THREE FULL SEMESTER CREDITS  Cost: $369
Requirements:
• 36 contact hours
• An outside assignment
(36 contact hours require conference participation Thursday - Saturday AND two preconference workshops.)

Accessing the Artist Within
Art Contest And Adapted Art Show

Anne Carlson Center of North Dakota is opening a contest for artists using adaptive equipment.

SUBMISSIONS ACCEPTED:

• Paintings
• Drawings
• Photography
• Musical
• Digital Art

Submissions are currently being accepted by the Anne Carlson Center and will be posted as they are received. A minimum of ten pieces of art will be selected to be shown at the 28th Annual Closing The Gap Conference, October 21-23, 2010.

Requirements: Age 5 - 21. Each artist must use some type of assistive technology to create his/her work of art.

For more information
www.accessingtheartistwithin.org
1-800-568-5175
PC-1 Multi-Modal Communication Strategies for Children Who Have Complex Communication Needs - PODD Communication Books (Two-Day Introductory Workshop)
Linda J. Burkhart, B.S., is a Special Educator/ Augmentative Communication Specialist/ Technology Integration Specialist in private practice, Eldersburg, MD and Dale Gardner Fox, M.S., RPT, is an Assistive Technology Consultant, Hampshire Educational Collaborative, CCATT, Northampton, MA.

PC-2 Getting Writing on the Radar for Students with the Most Significant Disabilities, Including Deaf-Blindness
Gretchen Hanser, Ph.D., is the Associate Director of School-Aged Services, Center for Literacy and Disability Studies, University of North Carolina, Chapel Hill, NC and Toy Dills Booth, M.Ed., NBCT, is a Special Educator, The North Shelby School, Shelby, NC.

PC-3 Reaching Every Learner with Free Technology
Paul Hamilton, M.Ed., is an Assistive Technology Consultant, SET-BC (Special Education Technology), Courtenay, BC, Canada.

PC-4 Facing the Challenges of Access with Students Who’ve Had Less Than Successful Experiences
Karen M. Kangas, OTR/L, ATP, is an Occupational Therapist, AT Specialist, Seating and Mobility Specialist and Clinical Educator in private practice, Karen M. Kangas OTR/L, Shamokin, PA.

PC-5 Evaluation of Effectiveness: The Role of Data in AT Assessment and Implementation
Jane Korsten, M.A., is a Speech Language Pathologist, AT Resource Specialist and Co-Author of EMC, Every Move Counts, Inc., Lee’s Summit, MO and Terry Foss, M.Ed., is an AT Resource Facilitator, Shawnee Mission Public Schools and Co-Author of EMC, Every Move Counts, Inc., Lee’s Summit, MO.

PC-6 Assistive Technology Supports for Struggling Students: Hands-On!
Pati King DeBaun, M.S., is a Speech Language Pathologist/Consultant specializing in assistive technology, Creative Communicating, Park City, UT and Dan Herlihy is an Assistive Technology/ Technology Resource Specialist, Connective Technology Solutions, Inc., Hoosick, NY.

PC-7 Expressive Communication Needs Across the Autism Spectrum - From AAC to Social Communication: Tech Tools for Assessment and Intervention
Susan L. Stokes, M.A., CCC-SLP, is an Educational Autism Consultant and Trainer in private practice, Fond du Lac, WI.

PC-8 “Help! I’m an AT Specialist and I Can’t Get Up!” Creating Manageable School-Based AT Services
Keri Huddleston, M.A., CCC-SLP, is an Assistive Technology Specialist, Teru Langsdale, M.S., CCC-SLP, is a Special Education Consultant, and Moira Soulis, M.S., CCC-SLP, is an Assistive Technology Specialist, all, Washoe County School District, Reno, NV.

PC-9 Teaching Reading When Students are at Emergent Level: For Students with Autism and Other Severe Disabilities of All Ages
Susan Norwell, M.A., is an Educational Specialist in private practice/Focused Learning Solutions and Instructor, Northeastern Illinois University, Buffalo Grove, IL.

PC-10 Supporting Students Using AAC Through a Core Vocabulary-Based Curriculum
Gail M. Van Tatenhove, M.S., CCC-SLP, is an AAC-focused Speech Language Pathologist in private practice and the President, AACell, Inc., Orlando, FL.

PC-11 Helping Teachers Integrate AIM in Classroom Instruction
Gayl Bowser, M.S. Ed., is an Independent Consultant, Roseburg, OR and Joy Smiley Zabala, Ed.D., ATP, is the Director of Technical Assistance, CAST and the National Center on AIM, Wakefield, MA.

PC-12 Keeping Current with Lite Tech AAC Systems and Innovations While Avoiding Technology Overload
Elizabeth (Libby) S. Rush, M.A., CCC-SLP, CPM, is an AAC Consultant in private practice, Durham, NC and Celeste Helling, M.A., CCC-SLP, ATP, is a Speech Language Pathologist, North Carolina Assistive Technology Program, Charlotte, NC.

PC-13 Literacy Frameworks that Guide Technology-Supported Assessment and Intervention
David A. Koppenhaver, Ph.D., is a Professor, Dept. of Language, Reading and Exceptionalities, Appalachian State University, Boone, NC and Barbara Woffak, M.S., CCC-SLP, is a Speech Pathologist, AAC and Assistive Technology Specialist, St. Paul Schools, St. Paul, MN.

PC-14 iPod touch, iPhone and iPad as Assistive Technology: From AAC to Planning Tool*
David Niemeijer, Ph.D., is the CEO, AssistiveWare, Amsterdam, Netherlands; Mark Coppin, B.S., is an Apple Distinguished Educator and the Director of Assistive Technology, Anne Carlson Center for Children, Jamestown, ND; Eric Sailer, M.A., CCC-SLP, is a Speech Language Pathologist and Assistive Technology Specialist, La Mesa-Spring Valley School District, La Mesa, CA; Jennifer Marden, M.S., M.A., is a Speech Language Pathologist, Technically Speaking, Rosindale, MA.

PC-15 Powered Mobility Assessment and Training with Children: How to, With What, Where, When and Why (especially for those children never previously considered candidates for powered mobility)
Karen M. Kangas, OTR/L, ATP, is an Occupational Therapist, AT Specialist, Seating and Mobility Specialist and Clinical Educator in private practice, Karen M. Kangas OTR/L, Shamokin, PA and Lisa Rotelli, A.S. in Physical Therapy, is an Educational Consultant, Adaptive Switch Labs, Inc., Spicewood, TX.

PC-16 Asperger Syndrome and School: What Does It Take, REALLY?
Keri Huddleston, M.A., CCC-SLP, is an Assistive Technology Specialist and Teru Langsdale, M.S., CCC-SLP, is a Special Education Consultant, Washoe County School District, Reno, NV.

PC-17 Literacy Instruction for Individuals with Complex Communication Needs
David McNaughton, Ph.D., is a Professor of Education, Dept. of Education Psychology, School of Psychology and Special Education, Penn State University, University Park, PA.

PC-18 Using 21st Century Tools for Teaching and Accessible Learning
Dan Herlihy is an Assistive Technology/ Technology Resource Specialist, Connective Technology Solutions, Inc., Hooisick, NY and Liz Medvetz is an Applications Training and Support Specialist, University at Albany, Albany, NY.

PC-19 Designing, Implementing and Evaluating Universal Design for Learning Interventions
Dave L. Edyburn, Ph.D., is a Professor, Dept. of Exceptional Education, University of Wisconsin-Milwaukee, Milwaukee, WI.

PC-20 Adding MORE to Your Bag of Tricks ... and Treats!
Mo Buti, M.A., is the Chicago Public Schools’ Coordinator of Autism and Cognitive Disabilities, Chicago, IL.

PC-21 Teaching Non-Verbal Children to Read: The Link Between Reading and Communication
Susan Norwell, M.A., is an Educational Specialist in private practice/Focused Learning Solutions and Instructor, Northeastern Illinois University, Buffalo Grove, IL.

PC-22 COMMUNICATION CIRCLES: With a Little Help from My Friends
Caroline Musselwhite, Ed.D., CCC-SLP, is an Assistive Technology Consultant and Author, AAC Intervention, Litchfield Park, AZ; Jerolyn Allen, M.Ed., OTR/L, ATACP, is an Occupational Therapist and Assistive Technology Coordinator, Litchfield Elementary School District, Litchfield Park, AZ; Jane Odom, M.Ed., is an Education Segment Manager, Prentke Romich Company, Surprise, AZ; Jan Pilling, M.S., is a Speech Language Pathologist, Brandon Public Schools, Brandon, MB, Canada; and Deanna Wagner, M.S., CCC-CLP, is an Assistive Technology Specialist, Madison Elementary School District, Phoenix, AZ.

PC-23 Flipping Over Adobe Acrobat
Judith P. Sweeney, M.A. Special Education, is an AT Consultant and the President, Onion Mountain Technology, Inc., Canton, CT.

PC-24 Teaching AAC
Pati King DeBaun, M.S., is a Speech Language Pathologist/Consultant specializing in assistive technology, Creative Communicating, Park City, UT and Karen Biggersstaff, M.S., is a Speech Language Pathologist/Consultant, San Antonio, TX.
CONFERENCE PRESENTERS For over 25 years, Closing the Gap has been bringing together distinguished leaders in the field to share their knowledge and expertise with others.

ADAMS, JON - Switch In Time, Littleton, MA
ALLEN, JEROLYN - Litchfield Elementary School District, Peoria, AZ
AMIN, HELAINE - ECI School for Children, Easton, MN
ARMSTRONG, CLAIRE - Bagley High School, Bagley, MN
BAILEY, LORALEE - District 196 Service Center, Rosemount, MN
BAKKEN, TARA - PACER Center, Bloomington, MN
BARGLOF, CARRIE - Storm Lake Community School District, Storm Lake, IA
BARINEAU, KAREN - DeKalb County Schools, Avondale Estates, GA
BARRY, MARY JO - Don Johnston Inc., Volo, IL
BECKER, TRINA - Eastern Illinois University, Charleston, IL
BENDER, ZACHARY - Don Johnston, Inc., Volo, IL
BOSCO WALSH, JEAN - Saltilco Corporation, Black Hawk, CO
BOTHUN, CHRISTINE - Therapy Network, Winona, MN
BOWKER, ADAM - Pennsylvania State University, University Park, PA
BOWSER, GAYL - Assistive Technology Collaborations, Marshall, MN
BRAUN, BOB - Southwest/West Central Service Cooperatives, Marshall, MN
BRESLIN LARSON, JOAN - Minnesota Dept. of Education, Roseville, MN
BRODBECK, DARLENE - ACES, Whitney High East, Madison, CT
BROWN, PAUL - Texthelp! Systems, Inc., Woburn, MA
BRUNE, PATRICK - DynaVox Mayer-Johnson, Wilton Manors, FL
BRYANT, PAT - AIMEE Solutions, Inc., Mundelein, IL
BURD, CASEY - ECI School for Children, Easton, NJ
BURGSTAHLER, SHERYL - DO-IT (Disabilities, Opportunities, Inter-networking and Technology), University of Washington, Seattle, WA
BURKHART, LINDA - Eldersburg, MD
BUTI, MO - Chicago Public Schools, Chicago, IL
BUTLER, MARCI - Don Johnston, Inc., Volo, IL
BUTTERFIELD, ROXANNE - Slater Software, Hot Springs, AR
BYE, CHRIS - Thinking Moves, River Falls, WI
CAFIERO, JOANNE - Cafiiero Communications, Rockville, MD
CAMPBELL, JONATHAN - SIMON Technology Center, PACER Center, Bloomington, MN
CAREW, DENISE - Penta Career Center, Perrysburg, OH
CARL, DIANA - Houston, TX
CARROLL, JASON - Innovative Communications Group, Lexington, KY
CASEY, KAREN - Durham CDSA, Durham, NC
CAVANAGH, CINDY - Mississippi Bend Area Education Agency, Bettendorf, IA
CHRISTENSEN, DAVID - Bagley High School, Bagley, MN
CLARK, JACQUELYN - N2Y, Inc., Huron, OH
CLARK HERZAN, WENDY - St. Lawrence College, Brockville Campus, Brockville, ON Canada
COPPIN, MARK - Anne Carlisle Center for Children, Jamestown, ND
COURDUFF, JENNIFER - Etiwanda School District, Etiwanda, CA
CRICK, ANN - Crick Software, Westport, CT
CRICK, JOHN - Crick Software, Inc., Westport, CT
CURTIS, TANYA - AugCom Solutions, LLC, Sheridan, MT
DAGEY, RYAN - TheArcLink, Inc., Bloomington, IN
DAHLQUIST, LORI - Adaptivation, Inc., Sioux Falls, SD
DASHNER, MEL - Origin Instruments Corp., Grand Prairie, TX
DAVIS, DAVID - Florida Instructional Technology Training & Resource Unit, Chipley, FL
DELISETIEN, JENNIE - Lifeworks Services, Eagan, MN
DUGGAN, MARIE - Technology for Autism Now, Inc., Boston, MA
DUNN, ALEXANDRA - Upper Canada District School Board, Oxford Mills, ON Canada
EBERSOLE, LAUREN - Littleton Public Schools, Centennial, CO
EDYBURN, DAVE - Dept. of Exceptional Education, University of Wisconsin, Milwaukee, WI
EISLEY, MARY MARGARET - Oshkosh Area School District, Oshkosh, WI
ENGLEMAN, MELISSA - East Carolina University, Greenville, NC
ENNIS-COLE, DEMETRIA - University of North Texas, Denton, TX
ERHARDT, RHODA P. - Erhardt Developmental Products, Maplewood, MN
ERICKSON, JON - Parlerai, Inc., Scoltae, MA
FEIT, SUZANNE - Cambium Learning Technologies, Marina Del Ray, CA
FIEGEN, TIM - Dakota State University, Madison, SD
FONNER, KELLY - Kelly Fonner Consulting, Lake Geneva, WI
FORE, MERRY - The Accendo Initiative, Rockport, TX
FOSS, TERRY - Every Move Counts, Inc., Lee’s Summit, MO
FOSTER, KATHY - Shenandoah Valley Regional Program, Rockingham County Public Schools, Harrisonburg, VA
FOX, GWIN - Shelby County School, Bartlett, TN
GARDNER FOX, DANEL - Hampshire Educational Collaborative CCATT Center, Northampton, MA
GIBSON, JASON - George Mason University, Fairfax, VA
GIBSON, JASON - University of Kentucky, Stanford, KY

40 www.closingthegap.com August / September, 2010
ACCESSIBLE INSTRUCTIONAL MATERIAL
300 Switch Hits a Day
A Sound-Based Alternative Method to Teach Students with Multiple Impairments to Recognize and Sort Objects
AIM Decision-Making Tools: Free Online at the National AIM Center (Two Block Session)
Alternative Formats 101: The Basics (Two Block Session)
An AT Win-Win: Community Teaming
Bookshare in the Classroom: Strategies for Success
Co:Writer 6: Bring Us Your Tired Writers, Your Poorest Performers, Your Huddled Masses with IEPs
Computers, Literacy and Young Children with Severe and Multiple Disabilities
Connect the Dots: Easy, Low Cost Uses of Assistive Technology in the Classroom (Two Block Session)
Create Your Own Computerized Intervention System for Students with Learning Disabilities: Integrating Charts, Video and Progress Notes
Equals Mathematics = Math for All
Fraction Action: Tools and Techniques for Making Fractions Accessible
Hot Off the Hard Drive: Click to Read Implementation: Get on the AT Bus Gus, Help Me Make a New Plan Stan
Inspiration: It's Not Just for Brainstorming!
Integrating AIM into Classroom Instruction: The Cliff Notes Version

Learning Applications for the Logan Prox Talker
Making All the Difference by Making It Different
Making Language and Literacy Visible in the Early Childhood Classroom
Read:OutLoud: How to Get eBooks and Make Them Accessible with Read:OutLoud
Track It ALL: AT, RTI and AIM - How? Assistive Technology Tracker Web is Here at Last
Using Digital Books to Close the Learning Gap for Students with Print Disabilities
WHICH BOOKS? Considerations for Selecting Accessible Print Materials for Students with Disabilities

ASSSESSMENT
Assessment That Drives Curriculum
Classroom Suite 4 Accessible Assessment: Is it a WANT or NEED?
Data Collection: Counting What Counts (Two Block Session)
Head Access, Why and How to Start Here, Especially When Head Control Seems Inconsistent
How Do I Know He's Really Reading?
New Ways to Jump Start Your AAC Evaluation Process
Personal Choices: Considering Self-Assessment
Prompting: How's That Workin' for Ya? (Two Block Session)
The Switch is Not the Activity (Two Block Session)
Transition Assessment and Curriculum
Where's My Teacher’s Manual?
Creating Math, Reading and Science Instructional Materials for Alternate Assessments

AUGMENTATIVE COMMUNICATION
AAC Evals: Tips and Toolkits
AAC on iPod and iPad: Hands-On with Proloquo2Go 2.0 (Two Block Session)
Aided Language Stimulation, Research to Practice (Two Block Session)
Alexicom Tech: World's First Internet-Based AAC System
All the Ways to Use Your Eyes - For Kids
Barriers to Acquiring AAC Devices: Solutions Revealed
Communication Intervention Possibilities with the iPhone, iPod touch and iPad (Two Block Session)
Designing Your Classroom to Build Language Skills
Enhancing Communication for Girls with Rett Syndrome: Improving Access and Regulating Sensory Input
Go Talk About What?
Hands-On Communication: Nurturing Communicative Intent through Tactile and Tangible Systems
Harnessing the Power of the Internet for Children with Special Needs
I + Want + That = Novel AAC Users
In-Depth Hands-On with iPod touch Assistive Technology Apps (Two Block Session)
IntelliTools Extreme! Focusing on the Student with Classroom Suite 4
Make and Take Literacy and AAC Activity
Mentoring and Modeling: AAC with a Little Help from My Friends
New Aphasia Apps and Devices from Lingraphica
Real Life Communication for Individuals with ALS
Rebuilding Communication for People with Aphasia: High Tech and Lite Tech Solutions
Springboard Lite and ALT-Chat: What is the Difference?
Strategically Switching In Including AAC Switch-Users in Group Activities
The Power of PODD: Autonomous Communication for Beginning Communicators (Two Block Session)
The VoicePal Levels: A Functional Tool for Teachers
Twitter for Poor Readers, Non-Readers and AAC Users
Working with Young Children Using Assistive Technology in the Home

AUTISM
Behavior Solutions and Autism: Light to High Tech
Comic Life and Web 2.0 Comics: Interactive Tools That Support Positive Social Behaviors
Creating a Web of Learning for Children with ASD: 28 Strategies
Creating and Sharing Visual Stories on the iPod touch and iPad
Developing Question Comprehension and Use: Theory and Research-Based Approaches
Expressive Communication Needs Across the Autism Spectrum - From AAC to Social Communication: Tech Tools for Assessment and Intervention (Two Block Session)
If I Can See It, I Can Do It! Hands-On (Two Block Session)
iParent: Using Visual Supports and Apple’s Technology and Others to Increase Comprehension and Functionality Across All Environments

Knowing What Works: A Research Review on AT and Autism

Life in the Real World

Lights, Camera, INTERACTION! Focusing on Video Modeling Techniques: An Inexpensive, Fast and Customized Solution for Improving Social Skills (Two Block Session)

S.O.S.: Socially Optimizing Solutions

This Kid Won’t Be Your Last, Trust Me! Classroom Strategies for Students with Social Differences

Using Music and Movement to Transform, Increasing Attention, Focus and Calm

VizZle: Practical Visual Language Applications (Two Block Session)

Web 2.0 Home/School Communication Systems

COGNITIVE REDEVELOPMENT

Pick & Choose: A Versatile Multipurpose Choice-Making Program

CURRICULUM DEVELOPMENT / MODIFICATIONS

A Roadmap to Adapting Curriculum: The POWER of T.H.E. P.A.C.T. (Two Block Session)

Academic Exploration through Switch Access

Adapting Math: An Easy Four-Step Instructional Formula

An Accessible On-Ramp to the Information Highway

Clicking in the Fast Lane with Clicker 5 and WriteOnline

Freedom to Speak: Using Speech Recognition Software with Students

It’s Showtime! Using Videos in Classroom Suite

Make Them Laugh - The Four-Blocks Way

No Problem! Just Give Me a Minute! (Two Block Session)

Supporting Literacy Learning with the Boardmaker Software Family

Totally Terrific Tips That Will Score You a Touchdown in Your Classroom! (Two Block Session)

Unique + Classroom Suite 4 = Student Success, Curriculum, Data

Using Clicker to Get Started with Early Literacy

Using Sequencing and Randomizing Switches to Encourage Young and Low-Functioning Children to Participate in School-Related Activities

DEAF COMMUNICATIONS

Overcoming Communications Barriers for Deaf and Hard of Hearing Students

DIFFERENTIATED INSTRUCTION

Becoming a Conventional Writer: Decreasing Prompts and Supports

Differentiated Learning Styles and AAC

From Planning to Publishing with WriteOnline

From Truant to Tycoon!

Rett Syndrome: Communication and Learning Strategies (Two Block Session)

Using PowerPoint 2007/2008 Themes to Differentiate

FUNCTIONAL LIVING SKILLS

10 Things I Can Do for Myself

Exploring Organizational Development: Tools and Methods

FUNDING

Funding AAC Systems

GERIATRICS

New Solutions for Vision Impaired Mac Users

INCLUSION / COOPERATIVE LEARNING

Note-Taking Continuums (Two Block Session)

SMART Inclusion = SMART Board + AT + Inclusive Practice + Critical Pedagogy (Two Block Session)

SMART Inclusion Classroom Demonstration: How do Interactive Whiteboards and AT Support Inclusion?

So, What’s the Difference? Co:Writer, SpellCatcher, Texthelp and WordQ’s Prediction

Take Note of OneNote: Note Taking, Organization, Collaboration and Beyond! (Two Block Session)

KEYBOARD ALTERNATIVES

Computer Accessibility for Those with Physical Impairments

Exploring Voice Recognition Options

LEARNING STYLES

Google in Your Classroom?

Livestructure Pulse Smartpen: Next Generation Audio Recording and Note Taking

Technology Training: Tips for Success

Wiggle Web 2.0 for 2010

LITERACY

ALL Write

Assistive Technology and Reading Boardmaker Family Products + Interactive Whiteboards = Engagement for the Entire Class

Building Literacy in Students with Moderate to Severe Disabilities Using Stories and AT

Experience the UDL Key to Student Success: Read&Write GOLD

News-2-You, Unique Learning System and SymbolStix ON-LINE: Inform and Include All Learners

Phonics Phun: Research to Practice for Older Students with Disabilities

Read&Write 4 GOLD for Mac: Discover the Newest Solution for Success (Two Block Session)

Shared Reading: It’s About the Interaction! (Two Block Session)

Students with Significant Disabilities as Writers: From Letter Exploration to Sound Spelling (Two Block Session)

Supporting Conventional Writing for Students with Disabilities: Tips and Tricks

Using Read Naturally’s Fluency Program with Blind and Visually Impaired Students

Writing Accommodations: The Spoken Word

PROFESSIONAL DEVELOPMENT

A Day in the Life of Three Ordinary Teachers: AT Professional Development the Web 2.0 Way

Data-Driven Decisions in Directing A University-Based Assistive Technology Training

Parents’ Guide to the Closing The Gap Conference

Professional Development That Works: Moving from Training to Implementation

QIAT Conversations 2010

Teaching Independent Living Skills

Using the Functional Skills System and the iPod touch

The Communication Enhancement Project: A School District’s Vision of Integrating AAC for Students with Significant Disabilities

Using Cloud Tools to Stretch the Impact of Your Professional Development Supports (Two Block Session)

RESEARCH

Software for Math in the UDL Classroom: A Research Study

Special Education Technology Research: What Have We Learned Lately?

Virtual Students: Working with Student Avatars

RESPONSE TO INTERVENTION

DO-IT: Research-Based Interventions That Maximize Transition to College

SCREEN ALTERNATIVES

Magnification and Multiple Monitors: Increasing Productivity for People with Low Vision

SEATING / POSITIONING / MOBILITY

Sensory Processing, Sensory Integration and Seating and Access (Two Block Session)

TECHNOLOGY INTEGRATION

3-D Worlds and Virtual Instruction: Addressing 21st Century Skills for Students with Disabilities

Amazing Technology to Support Hospital/Homebound Students

ARRA Funds: How’s That Working for You?

Can Everybody Hear My Colors?

Dan & Sam: Cool, Free or … You’ve Gotta Have It Applications!

Get an iLife! Tips and Tricks for iLife ’09

Hello I’m A Mac (Two Block Session)

iPad: Where the Computer Gaming Industry Meets Special Education

iPads, iPods and iTouch: Getting Files in, Getting Files Out

iPod touch and iPad for Children with Special Needs: AAC, AT and More

iPods are Cool and Now They are for School

Quick Content Creation Tools: Creating Engaging and Interactive Activities with Boardmaker Software Family (Two Block Session)

Using iPod Technology in High School and Post-Secondary Settings

Using the Joystick on a Powered Chair as a Mouse

We Read Your Eyes: Spring, The Eye-Controlled System

Wisconsin School District Prepares Students for Success with Literacy Technology

TRANSITION

Improving the Transition Planning Process: The Top 10 Things Everyone Should Know About the Transition Planning Process and Fostering Independence (Two Block Session)

UNIVERSAL DESIGN FOR LEARNING

An Overview of OpenOffice.org for Kids and OpenOffice.org

The AT Real-Time Band

Using Technology to Implement Universal Design for Learning in the Classroom

WEB 2.0

Developing Your Assistive Technology Personal Learning Network (PLN) Addressing...

How to Create Goal Oriented Vision Videos to Prepare Students for Their Futures
Below are the contracted companies to date

**Denotes Scavenger Hunt Sponsor**

- AAC Institute
- AAC TechConnect, Inc.
- AbleNet
- Accelerations Educational Software
- Adaptation, Inc.
- Adaptive Solutions
- Adaptive Switch Laboratories
- AIMEE Solutions, Inc.
- AMDi
- AssistiveWare
- Atomic Learning
- Attainment Company
- Augmentative Resources
- Beacon-Ridge
- BlueSky Designs, Inc.
- Bookshare
- Brightlines Paper
- Cadan Computers dba Technology for Education
- Cambium Learning Technologies
- CJT Enterprises, Inc.
- **Closing The Gap**
- Cognitopia Software
- Creative Communicating
- Crick Software, Inc.
- DO-IT, University of Washington
- Dolphin Computer Access, Inc.
- Don Johnston, Inc.
- DynaVox Mayer-Johnson
- Exceptional Parent
- Experia USA
- Flexiciser International
- Fraser
- HumanWare
- Inclusive TLC Special Needs InfoCor
- Judy Lynn Software, Inc.
- Laureate Learning Systems, Inc.
- Lightspeed Technologies, Inc.
- **Marblesoft - Simtech**
- ModularHose.com
- Monarch Teaching Technologies
- My Coin Chart
- N2Y Inc.
- Nasco
- Nuance Communications, Inc.
- Origin Instruments Corporation
- Parlerai, Inc.
- Point-and-Read, Inc.
- PointScribe
- Prentke Romich
- ProxTalker.com
- Quilted Illusions
- Read Naturally, Inc.
- RJ Cooper & Assoc., Inc.
- Saltillo Corporation
- Slater Software, Inc.
- SmartEd Services
- SoftTouch, Inc.
- Switch In Time
- Talking With Baby
- Tel • A • Vision
- Texthelp
- The Conover Company
- Thinking Moves
- Tobii
- Utechzone Co., Ltd.
- Words+, Inc.
- Writer Learning Systems

Ask questions, get answers – Companies exhibiting at Closing The Gap represent an impressive and varied scope of AT products and strategies from around the world, including knowledgeable reps and professionals with substantial experience in the field to best explain and demonstrate their solutions.

State-of-the-Art Commercial Exhibits

Wednesday evening through Saturday, October 20-23, 2010

Commercial Exhibits

Open to the public Saturday!

Scavenger Hunt Worth Over $2500 In Prizes

- **Read Naturally, Inc.**
- RJ Cooper & Assoc., Inc.
- Saltillo Corporation
- Slater Software, Inc.
- SmartEd Services
- SoftTouch, Inc.
- Switch In Time
- Talking With Baby
- Tel • A • Vision
- Texthelp
- The Conover Company
- Thinking Moves
- Tobii
- Utechzone Co., Ltd.
- Words+, Inc.
- Writer Learning Systems
CONFIRMATION
All who register by October 1, 2010 will receive confirmation by mail.

CONFERENCE DIRECTORY
The official Closing The Gap Conference Directory will be given to registrants at the conference site; many of the conference details will be posted on Closing The Gap’s Web site.

CANCELLATION POLICY
Cancellations must be received in writing by Closing The Gap on or before October 1, 2010. There will be a $75 cancellation fee for each one-day preconference workshop, each one-day conference registration, or each exhibit hall only registration; a $125 cancellation fee for each three-day conference registration. No refunds after October 1, 2010. Unpaid balances are due in full. Replacements are welcome and must be submitted in writing.

SCHOLARSHIPS
A limited number of scholarships are available for persons with disabilities or parents/guardians of children with disabilities. These scholarships cover registration fees for the conference only (Thursday - Saturday), and do not cover preconference workshops, food, lodging or travel. Scholarships are awarded on a first come, first served basis and one time only per person. Persons that have previously received a scholarship from Closing The Gap are not eligible.

To apply, complete a conference registration form, indicating your scholarship request. Submit the form and attach a letter describing your/your child’s disability and telling us why you would like to attend the conference. Applicants will receive written notification of acceptance or denial.

CONFERENCE HEADQUARTERS
Sheraton Bloomington Hotel and the adjacent Hotel Sofitel are the official hotels of the conference. All conference activities are held at these two hotels located just 10 minutes west of the Minneapolis-St. Paul International Airport. Limo, taxi, and mobility assistance services are available. Hotel-airport shuttles are available for Sheraton Bloomington Hotel.

TRAVEL
Minneapolis-St. Paul International Airport (MSP) has one airfield and two terminal buildings – the Lindbergh Terminal and the Humphrey Terminal. Thirteen commercial passenger airlines service the airport.

Conference goers are encouraged to choose the airline that best meets their needs and budget.

For detailed airport information, please visit http://www.mspairport.com/

For those interested in flying Delta, Closing The Gap has arranged for them to offer discounted conference rates. For the lowest possible airfares, in the United States and Canada, call Delta at 800-328-1111, Monday through Friday, 7:30 am - 7:30 pm Central Daylight Time and reference the Closing The Gap Conference, I.D. code NM585.

ACCESSIBLE TRANSPORTATION
To arrange for accessible transportation while visiting the Minneapolis area, have your ADA certifying agency fax your certification information along with the address where you will be staying and dates you plan on being in Minneapolis to 651-602-1660 four weeks prior to your arrival date. Riders must be ADA certified in the state in which they live. For questions regarding certification, call Jim Nieman at 651-602-1665. If you are not ADA certified, call Airport Taxi at 612-331-8294 (special assistance provided if requested).

HOTEL RESERVATIONS
Hotel reservations can be made by contacting the conference-site hotels directly. Please refer to the “Closing The Gap Conference” when making your reservations to receive conference room discounts when and where applicable. Both hotels have a limited number of handicapped accessible rooms.

For detailed airport information, please visit http://www.mspairport.com/
**2010 CLOSING THE GAP CONFERENCE REGISTRATION FORM**

First Name_________________________ Last Name_________________________

Mailing Address (home/work - please circle one) ______________________________________________________

City__________________________ State / Country__________________________ Zip Code / Postal Code________________

Daytime Phone_________________ Fax_________________ E-mail_________________________

Employer_________________________ Occupation____________________________________________

Is this your first time attending?  ❑ Yes  ❑ No  If no, most recent year attended _______ How did you hear about the conference?_________________________

*SPECIAL SERVICES* ❑ MS DOS text file ❑ Macintosh text file (Text file will be e-mailed.) ❑ Sign interpreter

*For persons with disabilities only - must be requested by September 1, 2010.*

---

### Conference - October 21-23, 2010

Includes Preview of Exhibits – Wednesday, October 20, 5:30 pm - 8:00 pm

<table>
<thead>
<tr>
<th>Registration Received</th>
<th>On or Before June 30</th>
<th>July 1 - September 9</th>
<th>September 10 - September 30</th>
<th>October 1 - Onsite</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Rate</td>
<td>$395</td>
<td>$435</td>
<td>$475</td>
<td>$505</td>
</tr>
<tr>
<td>Group Discount - 5 or more</td>
<td>$30 Deduct</td>
<td>$30 Deduct</td>
<td>$30 Deduct</td>
<td>$30 Deduct</td>
</tr>
<tr>
<td>Group Discount - 8 or more</td>
<td>$50 Deduct</td>
<td>$50 Deduct</td>
<td>$50 Deduct</td>
<td>$50 Deduct</td>
</tr>
</tbody>
</table>

**Parent Rate** (A letter describing your child's disability must accompany registration) $275

**Full-time Student Rate** (Proof of full-time student status must accompany registration) $275

**Presenter Rate** (Presentation title: ) $305

**Exhibitor Rate** (Company name and booth number: ) $305

---

**Single-Day and Exhibit Hall Only Registration**

- Friday Only - October 22 $250
- Saturday Only - October 23 $125
- Exhibit Hall Only - Wednesday evening through Saturday, October 20-23 $150

---

**CONFERENCE SCHOLARSHIP** (See page 45 for complete information.)

I am applying for a conference scholarship. A letter describing your/your child’s disability and telling us why you would like to attend the conference must be included.

**Preconference Workshops - October 19-20, 2010** (Includes Preview of Exhibits – Wednesday, October 20, 5:30 pm - 8:00 pm)

<table>
<thead>
<tr>
<th>Workshop</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC-1 Two-day PODD Workshop, Tuesday and Wednesday, October 19-20</td>
<td>$480</td>
</tr>
<tr>
<td>Tuesday, October 19 1st Choice PC-________ 2nd Choice PC-________</td>
<td>$270</td>
</tr>
<tr>
<td>Wednesday, October 20 1st Choice PC-________ 2nd Choice PC-________</td>
<td>$270</td>
</tr>
</tbody>
</table>

**BUNDLED PRICING! Tuesday and Wednesday Bundle ($50 savings)**

I will bring my own computer for:  ❑ PC-23  ❑ I will use Closing The Gap’s computer.  Participants in PC-3 and PC-19 MUST bring their own computer. $480

**MATERIAL FEE(S), IF APPLICABLE** (The materials fee equals the cost of the materials provided.)

<table>
<thead>
<tr>
<th>Materials Fee</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC-1 - $15 materials fee</td>
<td>PC-20 - $35 materials fee</td>
</tr>
<tr>
<td>PC-9 - $30 materials fee</td>
<td>PC-21 - $30 materials fee</td>
</tr>
<tr>
<td>PC-24 - $20 materials fee</td>
<td></td>
</tr>
</tbody>
</table>

---

**ACADEMIC CREDIT** (See page 38 for complete information and requirements.)

- One Semester Credit $123
- Two Semester Credits $246
- Three Semester Credits $369

**SUBSCRIPTION - AN ADDITIONAL NON-CONFERENCE OPTION** (See Web site or page 47 for more information.)

- One-year ONLINE subscription – $50
- One-year PRINT subscription – $36 (In the US); $52 (To Canada)
- Combination Subscription

- One-year ONLINE student subscription – $40
- One-year PRINT subscription – $64 (In the US); $92 (To Canada)
- One-year PRINT and ONLINE subscription – $75

---

**TOTAL AMOUNT** (Payment or purchase order must accompany registration.)

**PAYMENT INFORMATION**

Please Charge to my  ❑ Visa  ❑ MasterCard Card Number ______________________-______________________-______________________-_____________________

Exp Date: __________ Cardholder Address:_________________________________________________________________________________________________________

Please bill my agency or school district PO # ______________________________(Purchase order must accompany registration.)

Mail or fax form with payment or purchase order to: Closing The Gap, P.O. Box 68, Henderson, MN 56044; Fax 507-248-3810. **Or register online at:** <www.closingthegap.com>. All who register by October 1, 2010 will receive confirmation by mail. The official Closing The Gap Conference Directory will be given to registrants at the conference site; many of the conference details will be posted on Closing The Gap’s Web site. For additional information call 507-248-3294 or e-mail <info@closingthegap.com>.

Cancellations must be received in writing by Closing The Gap on or before October 1, 2010. $75 cancellation fee for each one-day preconference workshop, each one-day conference registration, or each exhibit hall only registration; $125 cancellation fee for each three-day conference registration. No refunds after October 1, 2010. Unpaid balances are due in full. Replacements are welcome and must be submitted in writing.
Discover Solutions, the print and online resources of Closing The Gap.


card of Special Needs

See for yourself how Closing The Gap Solutions makes finding and comparing AT products, implementation strategies and solutions easier than it has ever been before.

Learn more about an Online Solutions Subscription at: www.closingthegap.com/solutions

FREE 14-day Trial at: www.closingthegap.com/trial

Electronic Textbook

College and university instructors across the country have been choosing Closing The Gap Online Solutions as their textbook of choice!

Students qualify for a special $40 one-year subscription rate. Inquire for more details.

Closing The Gap

Assistive Technology Resources for Children and Adults with Disabilities

In the United States

- One year (six issues) $36
- Two years (12 issues) $64
- Combination, One-year Print and Online Subscription $75 (U.S. and Canada)

Resource Directory

$16.95 plus postage and handling

$7 in the United States; $7 to Canada

Quantity Discounts:

1-9 ________________________ $16.95
10-24 ________________ $14.50
25-49 __________________ $12.25
50-99 ________________ $10.50
100-999 ______________ $9.50
1,000 or more ......... $8.00

Free shipping and handling

If check in full payment accompanies an order for 10 or more directories (shipped within the United States only) Closing The Gap will pay shipping charges. Shipping and handling charges will be added to all invoices and credit card payments. Purchase orders will be accepted.

ONLINE SUBSCRIPTIONS:

- One-year Subscription $50
- One-Year Student Subscription $40
  (Proof of current enrollment must accompany order. E-mail or mail statement to Closing The Gap.)
- Combination, One-year Print and Online Subscription $75 (U.S. and Canada)

Site license:

Site License – number of users: ____________

(Purchase orders accepted.)

<table>
<thead>
<tr>
<th>Number of Users</th>
<th>Discount</th>
<th>Unit Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>10-49</td>
<td>25%</td>
<td>$37.50</td>
</tr>
<tr>
<td>50-99</td>
<td>50%</td>
<td>$25.00</td>
</tr>
<tr>
<td>100-299</td>
<td>60%</td>
<td>$20.00</td>
</tr>
<tr>
<td>300+</td>
<td>70%</td>
<td>$15.00</td>
</tr>
</tbody>
</table>

Please complete the following:

Name ____________________________

Organization ______________________

Mailing Address ______________________

City ___________________ State / Country __________ Zip / Postal code ____________

* Phone ______________________ Fax ______________________

* E-mail ______________________

* Required for Online Subscription and/or credit card orders

Occupation ______________________

Where did you hear about Closing The Gap? ______________________

☐ Check is enclosed $ ____________

☐ Please charge $ ____________ to Visa ☐ MasterCard

Credit card account number ______________________

Expiration date ______________________

Cardholder signature ______________________

Cardholder address ______________________

☐ Purchase order attached # ______________________

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:

5-99 ________________ $8.00
100-1,000 ____________ $7.50
1,001-10,000 _________ $7.00
10,001 or more ......... $6.50

(Allow 8 - 10 weeks for delivery of your first issue.)

Orders accepted on-line at www.closingthegap.com

Quantity Discounts:
GoTalk® Express 32 with scanning!

A bridge between lo-tech and hi-tech
- Visual and auditory scanning
- “Express” feature builds phrases or sentences
- 32 message buttons
- Five recording levels
- Buttons light when activated
- Four LEDs surround messages
- Auditory cueing
- Size: $14\frac{1}{4}” \times 10” \times 1\frac{3}{4}”$

Attainment Company, Inc.
P.O. Box 930160 • Verona, Wisconsin 53593-0160 USA
1-800-327-4269
www.AttainmentCompany.com